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Using this manual

Audience and scope

This manual guides you when using the PCIS-DASK software
driver for NUDAQ PCI bus data acquisition cards. This manual
also describes how to install and use the software library and meet
your requirements when creating programs for your software
applications.

How this manual is organized
This manual is organized as follows:

Chapter 1 Introduction: This chapter intoduces the PCIS-
DASK and lists all DAQ modules and language environments
which the program supports.

Chapter 2 Function Classes: This chapter describes the
classes of functions which the PCIS-DASK supports.

Chapter 3 Building Applications: This section describes the
fundamentals of building PCIS-DASK applications in Windows
and Linux.

Chapter 4 Application Hints: This chapter provides the PCIS-
DASK programming schemes for various DAQ operations.

Chapter 5 Continuous Data Transfer: This section illustrates
the mechanism and techniques that PCIS-DASK uses for con-
tinuous data transfer.

Chapter 6 Utilities: This chapter describes the Win32 and
PCIS-DASKI/X utilities.

Chapter 7 Sample Programs: This chapter provides some
PCIS-DASK sample programs for supported module

Chapter 8 Distribution of Applications: This section lists the
files, installers, and manual installation procedures needed
when distributing your PCIS-DASK-based applications.
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Conventions

Take note of the following conventions used throughout the man-
ual to make sure that you perform certain tasks and instructions

properly.

NOTE Additional information, aids, and tips that help you per-
form particular tasks.

IMPORTANT Critical information and instructions that you MUST perform to
complete a task.

WARNING Information that prevents physical injury, data loss, mod-
ule damage, program corruption etc. when trying to com-
plete a particular task.
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1 Introduction

The PCIS-DASK is a software development kit for NUDAQ data
acquisition cards utilizing the PCI bus. With high performance data
acquisition driver, the PCIS-DASK lets you develop custom appli-
cations under Windows® NT/98/2000/XP/Server 2003 and Linux
environments.

With memory and data buffer management capabilities, the PCIS-
DASK gives you freedom from dealing with complex issues and
focus more on developing your applications. The PCIS-DASK also
implements simple communication with NuDAQ PCI-bus cards,
while the easy-to-use functions allow you to utilize all the card’s
features in a high-level way.

The PCIS-DASK also delivers you the advantage of all the power
features of Microsoft® Win32 System and Linux for your data
acquisition applications, including running multiple applications
and using extended memory. The PCIS-DASK's flawless support
for Visual Basic environment makes it easy to create custom user
interfaces and graphics.

In addition to the software drivers, the PCIS-DASK comes with
sample programs for your reference. These sample programs help
you develop your applications quickly and conveniently.

Introduction 1
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Hardware Support

1.1 Hardware Support

The PCIS-DASK currently supports the following NuDAQ data
acquisition and NulPC CompactPCI cards:

vV VYV VYV VvV V VYV VvV VVYVVVVYVYyYVYYVY

NOTE

PCI-6202
PCI-6208A/cPCI-6208A

PCI-6208V/16V/cPCI-6208V

PCI-6308A
PCI-6308V
PCI-7200/cPCI-7200
PCI-7230/cPCI-7230
PCI-7233/PCI-7233H
PCI-7234

PCI-7224
PCI-7248/cPCI-7248
cPCI-7249R
PCI-7250

cPCI-7252

PCI-7256

PCI-7258

PCI-7260

PCI-7296
PCI-7300A/cPCI-7300A
PCI-7348

PCI-7350

VVVYVVV V VVVV VvV VvV VYVyVVYVYVYY

PCI-7396
PCI-7432/cPCI-7432
PCI-7433/cPCI-7433
PCI-7434/cPCI-7434
cPCI-7432R
cPCI-7433R
cPCI-7434R
PCI-7442

PCI-7443

PCI-7444

cPCI-7452

PCI-8554

PCI-9111
PCI-9112/cPCI-9112
PCI-9113

PCI-9114

cPCI-9116

PCI-9118

PCI-9221
PCI-9222/9223
PCI-9812/10

ADLINK periodically upgrades the PCIS-DASK for new

cards/modules. Check the card/modules’s Release
Notes to know if PCIS-DASK supports it.

Introduction
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Language Support

1.2 Language Support

The PCIS-DASK is a DLL (Dynamic-Link Library) version for use-
with Windows® and Linux environments. It works with any Win-
dows programming language that allows calls to a DLL. These
include Microsoft® Visual C/C++ (4.0 or higher versions), Borland
C++ (5.0 or higher versions), or Microsoft® Visual Basic (4.0 or
higher version). In Linux, it works with any 32-bit compiler, such as
gcc.

The PCIS-DASK also comes with a prototype function that sup-
ports Borland Delphi 2.x (32-bit) or higher versions.

Introduction 3
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4 Introduction
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2 Function Classes

This chapter describes the classes of functions that the PCIS-
DASK supports.

All PCIS-DASK functions are grouped into different classes:

» General Configuration Function Group
» Actual Sampling Rate Function Group
» Analog Input Function Group

> Analog Input Configuration Functions

> One-Shot Analog Input Functions

> Continuous Analog Input Functions

> Asynchronous Analog Input Monitoring Functions
» Analog Output Function Group

> Analog Output Configuration Functions

> One-Shot Analog Output Functions

> Continuous Analog Output Functions

> Asynchronous Analog Output Monitoring Functions
» Digital Input Function Group

> Digital Input Configuration Functions

> One-Shot Digital Input Functions

> Continuous Digital Input Functions

> Asynchronous Digital Input Monitoring Functions
» Digital Output Function Group

> Digital Output Configuration Functions

> One-Shot Digital Output Functions

> Continuous Digital Output Functions

> Asynchronous Digital Output Monitoring Functions
» Timer/Counter Function Group
» DIO Function Group

> Digital Input/Output Configuration Functions

> Dual-Interrupt System Setting Functions

> Local Interrupt Setting Functions

Function Classes 5
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Emergency Shutdown Function Group
Watchdog Timer Function Group
Hot-system Reset Hold Function Group
Calibration Function Group

SSI Function Group

PWM Function Group

Inter-Integrated Circuit (I2C) Function Group
Serial Peripheral Interface (SPI) Function Group

vVvy VVVVYVYY

6 Function Classes
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General Configuration Function Group

2.1 General Configuration Function Group

These functions initialize and configure data acquisition cards.

Register_Card

Release_Card

GetCardType

GetCardIndexFromID

GetBaseAddr

GetLCRAddr

SetlnitPattern

GetlnitPattern

IdentifyLED_Control

Initializes the hardware and software
states of a NuDAQ PCI-bus data acqui-
sition card. This function must be called
before any other DASK library functions.

Tells the DASK library that the registered
card is not in use and can be released.
This function makes room for a new card
to register.

Gets the card type of the device with a
specified card index.

Gets the card type and the sequence
number of the device with a specified
card ID.

Gets the 1/0O base addresses of the
device with a specified card index.

Gets the LCR base address (defined by
the PCI controller on board) of the
device with a specified card index.

Sets the state of the initial or safety-out
pattern.

Gets the state of relays set by the
onboard switches.

Controls identification LED.

Function Classes
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Actual Sampling Rate Function Group

2.2 Actual Sampling Rate Function Group

GetActualRate

GetActualRate 9524

Returns the actual sampling rate the
device will perform for the defined sam-
pling rate value.

Obtains the actual sampling rate the
PCI-9524 will perform according to the
board type and the specified rate.

Function Classes
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Analog Input Function Group

2.3 Analog Input Function Group

Analog Input Configuration Functions

Al_9111 Config

Al_9112 Config

Al_9113 Config

Al_9114 Config

Al_9116_Config

Al 9118 Config

Informs PCIS-DASK library of the trigger
source and trigger mode selected for the
analog input operation of PCI9-111. You
must call this function before calling
function to perform continuous analog
input operation of PCI-9111.

Informs PCIS-DASK library of the trigger
source selected for the analog input
operation of PCI-9112. You must call this
function before calling function to per-
form continuous analog input operation
of PCI-9112.

Informs PCIS-DASK library of the trigger
source selected for the analog input
operation of PCI-9113. You must call this
function before calling function to per-
form continuous analog input operation
of PCI-9113.

Informs PCIS-DASK library of the trigger
source selected for the analog input
operation of PCI-9114. You must call this
function before calling function to per-
form continuous analog input operation
of PCI-9114.

Informs PCIS-DASK library of the trigger
source, trigger mode, input mode, and
conversion mode selected for the ana-
log input operation of PCI-9116. You
must call this function before calling
function to perform continuous analog
input operation of PCI-9116.

Informs PCIS-DASK library of the trigger
source, trigger mode, input mode, and
conversion mode selected for the ana-

Function Classes
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Analog Input Function Group

log input operation of PCI9118. You
must call this function before -calling
function to perform continuous analog
input operation of PCI-9118.

Al 9221 Config Informs PCIS-DASK library of the trigger
source, trigger mode, and trigger proper-
ties selected for the analog input opera-
tion of PCI-9221. You must call this
function before calling function to per-
form continuous analog input operation
of PCI-9221.

Al_9222 Config Informs PCIS-DASK library of the trigger
source, trigger mode, and trigger proper-
ties selected for the analog input opera-
tion of PCI-9222. You must call this func-
tion before calling function to perform
continuous analog input operation of
PCI-9222.

Al_9223_Config Informs PCIS-DASK library of the trigger
source, trigger mode, and trigger proper-
ties selected for the analog input opera-
tion of PCI-9223. You must call this func-
tion before calling function to perform
continuous analog input operation of
PCI-9223.

Al_9524 Config Informs PCIS-DASK library of the trigger
source, trigger mode, and trigger proper-
ties selected for the analog input opera-
tion of PCI-9524. You must call this func-
tion before calling function to perform
continuous analog input operation of
PCI-9524.

Al_9812_Config Informs PCIS-DASK library of the trigger
source, trigger mode, and trigger proper-
ties selected for the analog input opera-
tion of PCI-9812. You must call this
function before calling function to per-

10 Function Classes



Al 9116 CounterInterval

Al_9221 Counterinterval

Al_9222 Counterinterval

Al_9223 Counterinterval

Al_9524 PollConfig

PCIS-DASK
Analog Input Function Group

form continuous analog input operation
of PCI-9812.

Informs PCIS-DASK library of the scan
interval value and sample interval value
selected for the analog input operation
of PCI-9116. You must call this function
before calling function to perform contin-
uous analog input operation of PCI-
9116.

Informs PCIS-DASK library of the scan
interval value and sample interval value
selected for the analog input operation
of PCI-9221. You must call this function
before calling function to perform contin-
uous analog input operation of PCI-
9221.

Informs PCIS-DASK library of the scan
interval value and sample interval value
selected for the analog input operation
of PCI-9222. You must call this function
before calling function to perform contin-
uous analog input operation of PCI-
9222 with internal clock.

Informs PCIS-DASK library of the scan
interval value and sample interval value
selected for the analog input operation
of PCI-9223. You must call this function
before calling function to perform contin-
uous analog input operation of PCI-
9223 with internal clock.

The function should be called if the Al
transfer mode is set to polling mode by
Al_9524 Config(). The function will start
ADC with the set speed and range. You
can use Al polling functions to get the
acquired value.

Function Classes
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Al _9524 SetDSP The function should be called if the load
cell Al operation will be performed. The
function sets DSP configurations for Al
load cell channels. Please refer PCI-
9524 hardware manual for details.

Al_InitialMemoryAllocated Gets the actual size of analog input
memory that is available in the device
driver.

Al_GetView Gets the mapped buffer address of the
analog input memory that is available in
the device driver.

Al_SetTimeOut Sets the Timeout period for Sync mode
of continuous Al.

One-Shot Analog Input Functions

Al_ReadChannel Performs a software triggered A/D con-
version (analog input) on an analog
input channel and returns the value con-
verted (unscaled).

Al_ReadChannel32 Performs a software triggered A/D con-
version (analog input) on an analog
input channel and returns the 32-bit
value converted (unscaled).

Al_VReadChannel Performs a software triggered A/D con-
version (analog input) on an analog
input channel and returns the value
scaled to a voltage in units of volts.

Al_ReadMultiChannels Performs software triggered A/D conver-
sions on the specified analog input
channels.

Al_ScanReadChannels Performs software triggered A/D conver-
sions on the specified analog input
channels.

Al_ScanReadChannels32 Performs software triggered A/D conver-
sions on the specified analog input
channels.

12
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Al _VoltScale32

PCIS-DASK
Analog Input Function Group

Converts the result from an
Al_ReadChannel call to the actual input
voltage.

Converts the result from an
Al_ReadChannel32 call to the actual
input voltage.

Continuous Analog Input Functions

Al_ContReadChannel

Al_ContScanChannels

Performs continuous A/D conversions
on the specified analog input channel at
a rate as close to the rate you specified.

Performs continuous A/D conversions
on the specified continuous analog input
channels at a rate as close to the rate
you specified. This function is only avail-
able for those cards that support auto-
scan functionality.

Al_ContReadMultiChannels

Performs continuous A/D conversions
on the specified analog input channels
at a rate as close to the rate you speci-
fied. This function is only available for
those cards that support auto-scan func-
tionality.

Al_ContReadChannelToFile

Performs continuous A/D conversions
on the specified analog input channel at
a rate as close to the rate you specified
and saves the acquired data in a disk
file.

Al_ContScanChannelsToFile

Performs continuous A/D conversions
on the specified continuous analog input
channels at a rate as close to the rate
you specified and saves the acquired
data in a disk file. This function is only

Function Classes

13



PCIS-DASK
Analog Input Function Group

available for those cards that support
auto-scan functionality.

Al_ContReadMultiChannelsToFile

Al_ContVScale

Al_ContStatus

Al_EventCallBack

Al_ContBufferReset

Al_ContBufferSetup

Performs continuous A/D conversions
on the specified analog input channels
at a rate as close to the rate you speci-
fied and saves the acquired data in a
disk file. This function is only available
for those cards that support auto-scan
functionality.

Converts the values of an array of
acquired data from an continuous A/D
conversion call to the actual input volt-
ages.

Checks the current status of the continu-
ous analog input operation.

Controls and notifies the user's applica-
tion when a specified DAQ event occurs.
The natification is performed through a
user-specified callback function.

Resets all the buffers set by function
“Al_ContBufferSetup” for continuous
analog input.

Sets up a specified buffer for continuous
analog input.

Asynchronous Analog Input Monitoring Functions

Al_AsyncCheck

Al_AsyncClear

Al_AsyncDblBufferMode

Checks the current status of the asyn-
chronous analog input operation.

Stops the asynchronous analog input
operation.

Enables or disables double buffer data
acquisition mode.

Al_AsyncDblBufferHalfReady

Checks whether the next half buffer of

14
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data in circular buffer is ready for trans-
fer during an asynchronous double-buff-
ered analog input operation.

Al_AsyncDblBufferTransfer
Copies half of the data of circular buffer
to user buffer. You can execute this
function repeatedly to return sequential
half buffers of the data.

Al_AsyncDblBufferOverrun
Checks or clears overrun status of the
double-buffered analog input operation.

Al_AsyncDblIBufferHandled
Notifies the PCIS-DASK that the ready
buffer has been handled in user applica-
tion.

Al_AsyncDblBufferToFile
Logs the data of the circular buffer to a
disk file.

Al_AsyncReTrigNextReady
Checks whether the data associated to
the next trigger signal is ready during an
asynchronous re-triggered analog input
operation.
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2.4 Analog Output Function Group

Analog Output Configuration Functions

AO_6202_Config

AO_6208A_Config

AO_6308A_Config

AO_6308V_Config

AO_9111_Config

AO_9112 Config

Inform the PCIS-DASK library of the trig-
ger source, trigger mode, and trigger
properties selected for the PCI-6202
with card ID CardNumber. You must call
this function before calling function to
perform continuous analog output oper-
ation.

Informs PCIS-DASK library of the cur-
rent range selected for the analog output
operation of PCI-6208A. You must call
this function before calling function to
perform current output operation.

Informs PCIS-DASK library of the cur-
rent range selected for the analog output
operation of PCI-6308A. You must call
this function before calling function to
perform current output operation.

Informs PCIS-DASK library of the polar-
ity (unipolar or bipolar) that the output
channel is configured for the analog out-
put and the reference voltage value
selected for the analog output chan-
nel(s) of PCI-6308V. You must call this
function before calling function to per-
form current output operation.

Informs PCIS-DASK library of the polar-
ity (unipolar or bipolar) that the output
channel is configured for the analog out-
put of PCI-9111. You must call this func-
tion before calling function to perform
voltage output operation.

Informs PCIS-DASK library of the refer-
ence voltage value selected for the ana-
log output channel(s) of PCI-9112. You

16
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must call this function before calling
function to perform voltage output oper-
ation.

Inform the PCIS-DASK library of the trig-
ger source, trigger mode, and trigger
properties selected for the PCI-9222
with card ID CardNumber. You must call
this function before calling function to
perform continuous analog output oper-
ation.

Inform the PCIS-DASK library of the trig-
ger source, trigger mode, and trigger
properties selected for the PCI-9223
with card ID CardNumber. You must call
this function before calling function to
perform continuous analog output oper-
ation.

AO_InitialIMemoryAllocated

AO_SetTimeOut

Gets the actual size of analog output
memory that is available in the device
driver.

Sets the Timeout period for Sync mode
of continuous AO.

Function Classes
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One-Shot Analog Output Functions

AO_WriteChannel Writes a binary value to the specified

analog output channel.

AO_VWriteChannel Accepts a voltage value, scales it to the
proper binary value and writes a binary
value to the specified analog output

channel.

AO_VoltScale Scales a voltage to a binary value.

AO_SimuWriteChannel Writes binary values to the specified
analog output channels simultaneously.

AO_SimuVWriteChannel Accepts voltage values, scales them to
the proper binary values and writes
binary values to the specified analog
output channels simultaneously.

18
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Continuous Analog Output Functions

AO_ContBufferReset

AO_ContBufferSetup

AO_ContWriteChannel

Reset all the buffers set by function
AO_ContBufferSetup for continuous
analog output.

Set up the buffer for continuous analog
output operation.

Performs continuous D/A conversions
on the specified analog output channel
at a rate as close to the rate you speci-
fied.

AO_ContWriteMultiChannels

AO_EventCallBack

AO_ContBufferCompose

AO_ContStatus

Performs continuous D/A conversions
on the specified analog output channels
at a rate as close to the rate you speci-
fied.

Controls and notifies the user's applica-
tion when a specified DAQ event occurs.

Fills the data for a specified channel in
the buffer for multi-channels of continu-
ous analog output operation.

Returns D/A status while performing
continuous D/A conversions.

Function Classes
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Asynchronous Analog Output Monitoring Functions

AO_AsyncCheck Check the current status of the asyn-
chronous analog output operation.

AO_AsyncClear Stop the asynchronous analog output
operation.

AO_AsyncDblBufferHalfReady
Checks whether the next half buffer is
ready for new data during an asynchro-
nous double-buffered analog output
operation.

AO_AsyncDblIBufferMode Enables or disables double-buffered
data acquisition mode.

20
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2.5 Digital Input Function Group

Digital Input Configuration Functions

DI_7200_Config

DI_7300A_Config
DI_7300B_Config

DI_7350_Config

Informs PCIS-DASK library of the trigger
source and trigger properties selected
for the digital input operation of PCI-
7200. You must call this function before
calling function to perform continuous
digital input operation of PCI-7200.

Informs PCIS-DASK library of the trigger
source and trigger properties selected
for the digital input operation of PCI-
7300A Rev.A or PCI-7300A Rev.B. You
must call this function before calling
function to perform continuous digital
input operation of PCI-7300A Rev.A or
PCI-7300A Rev.B.

Informs the PCIS-DASK library of the
selected port width, operation mode,
trigger mode, and sampled clock mode
for the PCle-7350 card with card ID.

DI_7350_ExportSampCLKConfig

Configures exported sampled clock con-
figurations of the PCle-7350 for continu-
ous digital input operation.

DI_7350 ExtSampCLKConfig

DI_7350_SoftTriggerGen

DI_7350_TrigHSConfig

Configures external sampled clock con-
figurations of the PCle-7350 for continu-
ous digital input operation.

Generates a software trigger signal for
digital input operation.

Configures advanced handshake and
trigger configurations of the PCle-7350
for continuous digital input operation.

Function Classes
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DI_9222_ Config Inform the PCIS-DASK library of the trig-
ger source, trigger mode, and trigger
properties selected for the PCI-9222
with card ID CardNumber.

DI_9223 Config Inform the PCIS-DASK library of the trig-
ger source, trigger mode, and trigger
properties selected for the PCI-9223
with card ID CardNumber.

DI_InitiaIMemoryAllocated
Gets the actual size of digital input DMA
memory that is available in the device
driver.

DI_GetView Gets the mapped buffer address of the
digital input memory that is available in
the device driver.

DI_SetTimeOut Sets the Timeout period for Sync mode
of continuous DI.

One-Shot Digital Input Functions

DI_ReadLine Reads the digital logic state of the speci-
fied digital line in the specified port.

DI_ReadPort Reads digital data from the specified
digital input port.
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Continuous Digital Input Functions

DI_ContReadPort

DI_ContReadPortToFile

DI_ContStatus

DI_EventCallBack

DI_ContMultiBufferSetup

DI_ContMultiBufferStart

DI_ContBufferReset

DI_ContBufferSetup

Performs continuous digital input on the
specified digital input port at a rate as
close to the rate you specified.

Performs continuous digital input on the
specified digital input port at a rate as
close to the rate you specified and
saves the acquired data in a disk file.

Checks the current status of the continu-
ous digital input operation.

Controls and notifies the user's applica-
tion when a specified DAQ event occurs.
The noatification is performed through a
user-specified callback function.

Set up the buffer for multi-buffered con-
tinuous digital input.

Starts the multi-buffered continuous digi-
tal input on the specified digital input
port at a rate as close to the rate you
specified.

Reset all the buffers set by function
DI_ContBufferSetup for continuous digi-
tal input.

Set up the buffer for continuous digital
input operation.

Function Classes
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Asynchronous Digital Input Monitoring Functions

DI_AsyncCheck

DI_AsyncClear

DI_AsyncDblBufferMode

Checks the current status of the asyn-
chronous digital input operation.

Stops the asynchronous digital input
operation.

Enables or disables double buffer data
acquisition mode.

DI_AsyncDblBufferHalfReady

Checks whether the next half buffer of
data in circular buffer is ready for trans-
fer during an asynchronous double-buff-
ered digital input operation.

DI_AsyncDblBufferHandled

DI_AsyncDblBufferToFile

Notifies PCIS-DASK the ready buffer
has been handled in user application.

For double buffer mode of continuous
DI, if the continuous DI function is
DI_ContReadPortToFile, call this func-
tion to log the data of the circular buffer
into a disk file.

DI_AsyncDblBufferTransfer

Copies half of the data of circular buffer
to user buffer. You can execute this
function repeatedly to return sequential
half buffers of the data.

DI_AsyncMultiBufferNextReady

Checks whether the next buffer of data
in circular buffer is ready for transfer dur-
ing an asynchronous multi-buffered digi-
tal input operation.

DI_AsyncDblBufferOverrun

Checks or clears overrun status of the
double-buffered digital input operation.
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DI_AsyncMultiBuffersHandled
Notifies PCIS-DASK the ready buffers
have been handled in user application.

DI_AsyncReTrigNextReady
Checks whether the data associated to
the next trigger signal is ready during an
asynchronous re-triggered digital input
operation.
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2.6 Digital Output Function Group

Digital Output Configuration Functions

DO_7200_Config

DO_7300A_Config
DO_7300B_Config

DO_7350_Config

Informs PCIS-DASK library of the trigger
source and trigger properties selected
for the digital input operation of PCI-
7200. You must call this function before
calling function to perform continuous
digital output operation of PCI-7200.

Informs PCIS-DASK library of the trigger
source and trigger properties selected
for the digital input operation of PCI-
7300A Rev.A or PCI-7300A Rev.B. You
must call this function before calling
function to perform continuous digital
output operation of PCI-7300A Rev.A or
PCI-7300A Rev.B.

Informs the PCIS-DASK library of the
selected port width, operation mode,
trigger mode, and sampled clock mode
for the PCle-7350 card with card ID.

DO_7350_ExportSampCLKConfig

Configures exported sampled clock con-
figurations of the PCle-7350 for continu-
ous digital output operation.

DO_7350_ExtSampCLKConfig

DO_7350_SoftTriggerGen

DO_7350_TrigHSConfig

Configures external sampled clock con-
figurations of the PCle-7350 for continu-
ous digital output operation.

Generates a software trigger signal for
digital output operation.

Configures advanced hand hake and
trigger configurations of the PCle-7350
for continuous digital output operation.
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Inform the PCIS-DASK library of the trig-
ger source, trigger mode, and trigger
properties selected for the PCI-9222
with card ID CardNumber.

Inform the PCIS-DASK library of the trig-
ger source, trigger mode, and trigger
properties selected for the PCI-9223
with card ID CardNumber.

Informs PCIS-DASK library of the mode
of EDO channels of PCI-9111.

DO_InitiaIMemoryAllocated

DO_GetView

DO_SetTimeOut

Gets the actual size of digital output
DMA memory that is available in the
device driver.

Gets the mapped buffer address of the
digital output memory that is available in
the device driver.

Sets the Timeout period for Sync mode
of continuous DO.

Function Classes
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One-Shot Digital Output Functions

DO_WriteLine

DO_WritePort

DO_SImuWritePort

DO_ReadLine

DO_ReadPort

DO_WriteExtTrigLine

Sets the specified digital output line in
the specified digital output port to the
specified state. This function is only
available for those cards that support
digital output read-back functionality.

Writes digital data to the specified digital
output port.

Write the output digital data to the speci-
fied digital output port simultaneously.

Reads the specified digital output line in
the specified digital output port.

Reads digital data from the specified
digital output port.

Sets the digital output trigger line to the
specified state. This function is only
available for PCI-7200.
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Continuous Digital Output Functions

DO_ContWritePort Performs continuous digital output on
the specified digital output port at a rate
as close to the rate you specified.

DO_ContStatus Checks the current status of the continu-
ous digital output operation.

DO_EventCallBack Controls and notifies the user's applica-
tion when a specified DAQ event occurs.
The notification is performed through a
user-specified callback function.

DO_PGStart Performs pattern generation operation.
DO_PGStop Stops pattern generation operation.

DO_ContMultiBufferSetup Set up the buffer for multi-buffered con-
tinuous digital output.

DO_ContMultiBufferStart Starts the multi-buffered continuous digi-
tal output on the specified digital output
port at a rate as close to the rate you
specified.

Asynchronous Digital Output Monitoring Functions

DO_ContBufferReset Reset all the buffers set by function
DO_ContBufferSetup for continuous dig-
ital output.

DO_ContBufferSetup Set up the buffer for continuous digital
output operation.

DO_AsyncCheck Checks the current status of the asyn-
chronous digital output operation.

DO_AsyncClear Stops the asynchronous digital output
operation.

DO_AsyncMultiBufferNextReady
Checks whether the next buffer is ready
for new data during an asynchronous
multi-buffered digital output operation.
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2.7 Timer/Counter Function Group

Timer/Counter Functions

CTR_Setup

CTR_Read

CTR_Clear

CTR_Update

CTR_8554_CIlkSrc_Config
CTR_8554_CK1_Config

Configures the selected counter to oper-
ate in the specified mode.

Reads the current contents of the
selected counter.

Sets the output of the selected counter
to the specified state.

Writes a new initial count to the selected
counter.

Sets the counter clock source.
Sets the source of CK1.

CTR_8554 Debounce_ConfigSets the debounce clock.

General-Purpose Timer/Counter Functions

GCTR_Setup

GCTR_Read

GCTR_Clear

GPTC_9524 PG_Config

GPTC_Clear

GPTC_Control

GPTC_EventSetup

Controls the general-purpose counter to
operate in the specified mode.

Reads the current counter value of the
general-purpose counter.

Clears the general-purpose timer/coun-
ter control register and counter register.

This function sets the generated pulse
number of GPTC pulse generator.

Halts the specified general-purpose
counter operation and reloads the initial
value of the timer/counter.

Controls the selected counter/timer by
software.

Sets the configurations of the selected
event of the counter/timer.
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GPTC_EventCallBack Controls and notifies the user's applica-
tion when a specified GPTC event
occurs.

GPTC_Read Reads the counter value of the general-

purpose counter without disturbing the
counting process.

GPTC_Setup Sets the configurations of the selected
counter/timer.
GPTC_Status Reads the latched GPTC status of the

general-purpose  counter/timer  from
GPTC status register.
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2.8 Digital Input/Output Function Group

Digital Input/Output Configuration Functions

DIO_LineConfig

DIO_LinesConfig

DIO_PortConfig

DIO_7350_AFIConfig

DIO_VoltLevelConfig

This function is only used by the Digital
I/O cards whose I/O port can be set as
input port or output port. This function
informs PCIS-DASK library of the line
direction selected for the digital input/
output operation. You must call this func-
tion before calling functions to perform
digital input/output operation.

This function is only used by the Digital
I/O cards whose I/O port can be set as
input port or output port. This function
informs PCIS-DASK library of the entire
lines direction of the port selected for the
digital input/output operation. You must
call this function before calling functions
to perform digital input/output operation.

This function is only used by the Digital
I/O cards whose I/O port can be set as
input port or output port. This function
informs PCIS-DASK library of the port
direction selected for the digital input/
output operation. You must call this func-
tion before calling functions to perform
digital input/output operation.

Configures the AFI port of the 7350 to
be as the COS or PM event out.

Configures the voltage level for the
specified port type.
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Dual-Interrupt System Setting Functions

DIO_SetDuallnterrupt

DIO_SetCOSiInterrupt

DIO_SetCOSinterrupt32

DIO_GetCOSLatchData

DIO_GetCOSLatchData32

DIO_INT_EventMessage

DIO_INT1_EventMessage

DIO_INT2_EventMessage

DIO_PMConfig

Controls two interrupt sources of Dual
Interrupt system.

Sets the ports used for COS interrupt
detection.

Sets the ports with 32-bit data width
used for COS interrupt detection.

Get the DI data that latched in the COS
Latch register while the Change-of-State
(COS) interrupt occurred.

Get the DI data with 32-bit data width
that latched in the COS Latch register
while the Change-of-State (COS) inter-
rupt occurred.

Controls and notifies the user's applica-
tion when an interrupt event occurs. The
notification is performed through a user-
specified callback function or the Win-
dows PostMessage API.

Controls the interrupt sources of INT1 of
Dual Interrupt system and notifies the
user's application when an interrupt
event occurs. The notification is per-
formed through a user-specified call-
back function or the Windows
PostMessage API.

Controls the interrupt sources of INT2 of
Dual Interrupt system and notifies the
user's application when an interrupt
event occurs. The notification is per-
formed through a user-specified call-
back function or the Windows
PostMessage API.

Sets the configurations of pattern
matching.

Function Classes
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DIO_PMControl Controls the pattern match operation.

DIO_GetPMLatchData32 Gets the 32-bit width DI data latched in
the pattern match latch register while the
pattern match interrupt occurs.
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Local Interrupt Setting Functions

DIO_7300SetInterrupt

Controls the interrupt sources (AUXDI
and Timer2) of local Interrupt system of
PCI-7300A/cPCI-7300A.

DIO_AUXDI_EventMessageControls AUXDI Interrupt and notifies

DIO_T2_EventMessage

the user's application when an interrupt
event occurs. The notification is per-
formed through a user-specified call-
back function or the Windows
PostMessage API.

Controls Timer2 Interrupt and notifies
the user's application when an interrupt
event occurs. The notification is per-
formed through a user-specified call-
back function or the Windows
PostMessage API.
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2.9 Emergency Shutdown Function Group

EMGShutDownControl Controls emergency shutdown.
EMGShutDownStatus Returns the emergency shutdown condi-
tion.

2.10 Watchdog Timer Function Group

WDT_Control Control watchdog timer.

WDT_Reload Reload watchdog timer counter.

WDT_Setup Setup a watchdog timer.

WDT_Status Get the overflow status of a watchdog
timer

2.11 Hot-system Reset Hold Function Group
HotResetoldStatus Read hot reset hold status.

HotResetHoldControl Controls hot-system reset DO hold func-
tion. Hold the current DO output value
while your computer is hot reset if hot-
reset-hold is enabled. Otherwise, the ini-
tial pattern is outputted.

2.12 Calibration Function Group

PCI_DB_Auto_Calibration_ALL
Calibrates the specified device.

PCI_EEPROM_CAL_Constant_Update
Saves new calibration constants to the
specified EEPROM bank.

PCl_Load_CAL_Data Loads calibration constants from the
specified EEPROM bank.

PCI9524 Acquire_AD_CalConst
Obtains the AD calibration constants of
PCI-9524.

PCI9524 Acquire_DA_CalConst
Obtains the DA calibration constants of
PCI-9524.
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2.13 SSI Function Group

SSI_SourceClear Disconnects all of the device signals
from the SSI bus trigger lines.

SSI_SourceConn Connects a device to the specified SSI
bus trigger line.

SSI_SourceDisConn Disconnects a device signal from the
specified SSI bus trigger line.

2.14 PWM Function Group

PWM_Output Start the PWM output.

PWM_Stop Stop the PWM output.
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2.15 Inter-Integrated Circuit (I1°C) Function Group

I2C_Control

I2C_Read

12C_Setup

12C_Status

12C_Write

Controls the specified Inter-Integrated
Circuit (IZC) port with the specified con-
trol operation.

Reads the data from the specified Inter-
Integrated Circuit (I2C) port with the
specified slave address.

Sets the configurations of the specified
Inter-Integrated Circuit (1°C) port.

Obtains the status of the specified Inter-
Integrated Circuit (1°C) port.

Writes the data to the specified Inter-
Integrated Circuit (I°C) port with the
specified slave address.
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2.16 Serial Peripheral Interface (SPI) Function Group

SPI_Control

SPI_Read

SPI_Setup

SPI_Status

SPI_Write

Controls the specified Serial Peripheral
Interface (SPI) port with the specified
control operation.

Reads the data from the specified Serial
Peripheral Interface (SPI) port with the
specified slave address.

Sets the configurations of the specified
Serial Peripheral Interface (SPI) port.

Obtains the status of the specified Serial
Peripheral Interface (SPI) port.

Writes the data to the specified Serial
Peripheral Interface (SPI) port with the
specified slave address.

Function Classes

39



PCIS-DASK
Serial Peripheral Interface (SPI) Function Group

40 Function Classes



PCIS-DASK
Contiguous Memory Allocation

3 Building Applications

3.1 Contiguous Memory Allocation

The PCIS-DASK features continuous data transfer functions that
input or output blocks of data to or from an installed NuDAQ PCI
device. To prevent reduced data transfer performance caused by
memory fragment, the PCIS-DASK allocates physically contigu-
ous buffers in device driver at system startup time (Windows® 98)
or when system boots (Windows® NT/2000/XP/2003 and Linux).

The PCIS-DASK comes with the PciUtil applications to set or
modify the sizes of contiguous memory allocated in the driver for
continuous analog input, analog output, digital input, and digital
output. Device drivers allocates these memory sizes. The size of
initially allocated memory is the maximum memory size that con-
tinuous data transfer can be performed. Refer to the NuDAQ Reg-
istry/Configuration utility section for details.

For input operations, the specified data count are transferred to
the driver buffer while the PCIS-DASK copies the data from the
driver buffer (kernel level) to a user buffer (user level). For output
operations, PCIS-DASK copies the data from a user buffer (driver
level) to the driver buffer (kernel level) and transfers outgoing data
from the driver buffer to the NuDAQ PCI device.

When performing only polling I/O, the initial allocated memory is
not needed and you may use the NuDAQ Registry/Configuration
utility to set the buffer size to 0.
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3.2 Application Building Fundamentals in Windows

The following sections provide fundamental instructions when
using PCIS-DASK to build application in Windows® NT/98/2000/
XP/Server 2003 operating environment.

Using Microsoft® Visual C®/C++®

Follow these steps to create a data acquisition application using
PCIS-DASK and Microsoft Visual C/C++.

1. Launch the Microsoft Visual C/C++ application.

2. Open a new or existing project that you want to apply the
PCIS-DASK.

3. Include header file DASK.H in the C/C++ source files
that call PCIS-DASK functions. DASK.H contains all the
function declarations and constants that can be used to
develop data acquisition applications. Incorporate the
following statement in the code to include the header file.

#include “DASK.H”

4. After setting the appropriate compile and link options,
build the application by selecting the Build command
from Build menu (Visual C/C++ 4.0). Remember to link
PCIS-DASK'’s import library, PCIS-DASK.LIB.
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Using Microsoft® Visual Basic®

Follow the steps in the succeeding sections to create a data acqui-
sition application using PCIS-DASK and Visual Basic.
Open a project
Do one of the following to open a new or existing project:
1. Open a new project by selecting the New Project com-
mand from the File menu. To open an existing project,

select the Open Project command from the File menu to
display the Open Project dialog box.

Open Project [7]x]

Logk in: I 23 Microsoft Visual Basic ﬂ | fi |

bitmaps [ report Auto32ld.vbp

cligwr @ samples

he ] setup

iconz @ setupkit

include (Dve0nine

metafile (1 winapi
File: name: || Open I
Files of type: I Praject Files(™.Vbp:* Mak] j Cancel

2. Locate the existing project, then double-click on the
project file name to load.

Add the file

You must add the file DASK.BAS to the project, if the file is not yet
included. This file contains all the procedure declarations and con-
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stants that can be used to develop the data acquisition application.
To add the file:

1. Select Add File from the File menu. The Add File window
appears, displaying a list of files in the current directory.

Add File H

Loak i Iamcluda j gl l_

File name: |Dask baz Open I
Files of type:  [VB Filesl” Fm;* Bas.”.Cls," Fies) =l T

2. Double-click on the DASK.BAS file. If the file is not on
the list, make sure the list is displaying files from the cor-
rect directory. By default, the DASK.BAS file is installed
at C:\ADLInk\PCIS-DASK\INCLUDE.
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Design the interface

To design the interface for the application, place all the interface
elements such as command buttons, list boxes, and text boxes on
the Visual Basic form. These standard controls are available from
the Visual Basic Toolbox.

To place a control on the form, select the desired control from the
Toolbox, then draw it on the form. You may also double-click on
the control icon from the Toolbox to place it on the form.

Set the interface controls

To view the property list, click the desired control, then choose the
Properties command from the View menu, or press F4. You may
also click on the Properties button [g&] from the toolbar.

Write the event code

The event code defines the required action to be performed when
an event occurs. To write the event code, double-click on the con-
trol or form to view the code module, then add the event code. You
can also call the functions declared in the DASK.BAS file to per-
form data acquisition operations.

Run the application

Do one of the following to run the application:
» Choose Start from the Run menu
» Click the Start icon from the toolbar
» Press <F5>

Distribute the application

After completing the project, save the application as an executable
(.EXE) file using the Make EXE File command from the File menu.
The application, after being transformed into an executable file, is
now ready for distribution.

You must include the PCIS-DASK's DLL and driver files when the
application is distributed. Refer to Chapter 5: Continuous Data
Transfer for the details.
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3.3 Application Building Fundamentals in Linux

The following sections provide fundamental instructions when
using PCIS-DASK to build application in Linux. To create a data
acquisition application using PCIS-DASK/X and GNU C/C++, fol-
low these steps:

Edit the source files

Include the header file dask.h in the C/C++ source files that call
PCIS-DASKI/X functions. The dask.h has all the function declara-
tions and constants that you can use to develop your data acquisi-
tion application. Add this statement in your code to include the
header file.

#include "dask.h"
Build your application

Using the appropriate C/C++ compiler (gcc or cc) to compile the
program. You should add -Ipci_dask option to link
libpci_dask.so library. For multi-threaded applications, the
-Ipthread string is required. For example:

gcc -0 testai testai.c -Ipci_dask
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3.4 Application Building Fundamentals Using .NET

The following sections provide fundamental instructions when
using PCIS-DASK to build application in Linux. To create a data
acquisition application using PCIS-DASK/X and GNU C/C++, fol-
low these steps:

Using Microsoft VB.net.

To create a data acquisition application using PCIS-DASK and
VB.net, follow these steps after entering VB.net:

1. Open a new or existing project.

2. Add the file DASK.vb to the project, if the file is not yet
included. This file contains all the procedure declarations
and constants that can be used to develop the data
acquisition application. To add the file:

» Select Add File from the File menu. The Add Existing Item
window appears, displaying a list of files in the current direc-

to ry.
Add Existing Item - WindowsApplication2 X
Look n: [5) Include ] e - X 5 EH - Tooks~
%] DASK vb

Historr

e

My Projects

P
Dieskiop
[ *]
Faworites
f%% Fille panme: [ =] Open -

)] =

E Files of bype: VE Code Files (v b rores Tl Cancel

» Double-click on the DASK.vb file. If the file is not on the list,
make sure the list is displaying files from the correct direc-

Building Applications 47



PCIS-DASK
Application Building Fundamentals Using .NET

tory. By default, the DASK.vb file is installed at
C:\ADLINK\PCIS-DASK\INCLUDE.

3. Develop the application. You can call the functions that
are declared in the file Dask.vb to perform data acquisi-
tion operations.

4. Run your application. Do one of the following to run the
application:

> Choose Start from the Run menu
> Click the Start icon from the toolbar
> Press <F5>

5. Distribute the application. After completing the project,
save the application as an executable (.EXE) file using
the Make EXE File command from the File menu. The
application, after being transformed into an executable
file, is now ready for distribution. You must include the
PCIS-DASK’s DLL and driver files when the application
is distributed. Refer to Chapter 8: Distribution of
Applications for the details.
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Using Microsoft C#

To create a data acquisition application using PCIS-DASK and C#,
follow these steps after entering C#:

1. Open a new or existing project.

2. Add the file DASK.cs to the project, if the file is not yet
included. This file contains all the procedure declarations
and constants that can be used to develop the data
acquisition application. To add the file:

> Select Add File from the File menu. The Add Existing
Item window appears, displaying a list of files in the cur-
rent directory.From the Project menu, select the Add
Existing Item command. The Add Existing Item window
appears, displaying a list of files in the current directory.

o - ¥ lizafionl x|
Look fn: IDImlude j(:v 8 X [ B - Tools~
History
s
My Projects
P
Dieskiop
£
Farvorites
f%% File name: | =] Open -
(] £
7= Fiksof trpe:  [CF Fies (o9 o [ Gt ]
2

» Double-click on the DASK.cs file. If the file is not on the list,
make sure the list is displaying files from the correct direc-
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tory. By default, the DASK.cs file is installed at
C:\ADLINK\PCIS-DASK\INCLUDE.

3. Develop the application. You can call the functions that
are declared in the file Dask.cs to perform data acquisi-
tion operations.

4. Run your application. Do one of the following to run the
application:

> Choose Start from the Run menu
> Click the Start icon from the toolbar
> Press <F5>

5. Distribute the application. After completing the project,
save the application as an executable (.EXE) file using
the Make EXE File command from the File menu. The
application, after being transformed into an executable
file, is now ready for distribution. You must include the
PCIS-DASK’s DLL and driver files when the application
is distributed. Refer to Chapter 8: Distribution of
Applications for the details.
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Creating Windows® PCIS-DASK Application Using
Microsoft VB.net.

To create a data acquisition application using DASK and C#, fol-
low these steps after entering VB.net:

1. Open a new or existing project.

2. Add the file DASK.vb to the project, if the file is not yet
included. This file contains all the procedure declarations
and constants that can be used to develop the data
acquisition application. To add the file:

> Select Add File from the File menu. The Add Existing
Item window appears, displaying a list of files in the cur-
rent directory.From the Project menu, select the Add
Existing Item command. The Add Existing Item window
appears, displaying a list of files in the current directory.

Add Existing [tem - WindowsApplication? X

Lock in: [ Inslude x| = * 04 - Took-
& Wd-dask vb
History
o
My Projecis
P
Deskiop
]
Favarites
@% File pame: [ -] Open - |
] 5
> Filesoftvpe:  [VE Code Files (%vb*renc ol Fovadl) | Cancel

» Double-click on the DASK.vb file. If the file is not on the list,
make sure the list is displaying files from the correct direc-
tory. By default, the DASK.vb file is installed at
C:\ADLINK\PCIS-DASK\INCLUDE.

3. Develop the application. You can call the functions that
are declared in the file DASK.vb to perform data acquisi-
tion operations.
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4. Run your application. Do one of the following to run the
application:

> Choose Start from the Run menu

> Click the Start icon from the toolbar

> Press <F5>

5. Distribute the application. After completing the project,
save the application as an executable (.EXE) file using
the Make EXE File command from the File menu. The
application, after being transformed into an executable
file, is now ready for distribution. You must include the
PCIS-DASK’s DLL and driver files when the application
is distributed. Refer to Chapter 8: Distribution of
Applications for the details.

Using Callback Functions in a VB.net Application with
PCIS-DASK
To use callback functions in a VB.net application with PCIS-DASK,

follow these steps after creating a Windows® 2000/XP PCIS-
DASK application using VB.net:

1. Create a callback function. For example:

Sub CallBack()
//Add the VB.Net function you like.
End Sub

2. Set the callback function. For example:

Al_EventCallBack(dev, 1, DBEvent, AddressOf
CallBack);
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Using Callback Functions in a C# Application with PCIS-
DASK

To use callback functions in a c# Application with PCIS-DASK, fol-
low these steps after creating a Windows® 2000/XP PCIS-DASK
application using C#:

1. Create a callback function. For example:

private static void CallBack(Q)
{

}

2. Set the callback function. For example:

CallbackDelegate del = new Callback Delegate(
CallBack );

DASK.AIl_EventCallBack((ushort)card, 1,
DASK.DBEvent, del);

//Add the C# function you like.
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4  Application Hints

This chapter provides the programming schemes showing the
function flow of that PCIS-DASK performs analog I/O and digital I/
0.

The figure below shows the basic building blocks of a PCIS-DASK
application. However, except using Register_Card at the begin-
ning and Release_Card at the end, depending on the specific
devices and applications you have, the PCIS-DASK functions
comprising each building block vary.

Register_Card

Configuration Function

Al/AO/DI/DO
Operation Function

Release_Card

The programming schemes for analog input/output and digital
input/output are described individually in the following sections.
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4.1 Analog Input

PCIS-DASK provides two kinds of analog input operation: nonbuf-
fered single-point analog input readings and buffered continuous
analog input operation.

The non-buffered single-point Al uses software polling method to
read data from the device.

The buffered continuous analog input uses interrupt transfer or
DMA transfer method to transfer data from device to user's buffer.
The maximum number of count in one transfer depends on the
size of initially allocated memory for analog input in the driver. The
driver allocates the memory at system boot (in Windows® NT) or
Windows startup time (in Windows® 98). It is recommended that
the Al_InitialMemoryAllocated function be used to get the size of
initially allocated memaory before performing continuous Al opera-
tion.

The buffered continuous analog input includes:

» synchronous continuous Al

» non-triggered non-double-buffered asynchronous continu-
ous Al

» non-triggered double-buffered asynchronous continuous Al

» triggered non-double-buffered asynchronous continuous Al

» triggered double-buffered asynchronous continuous Al
These are described in section to section . For special consider-

ation and performance issues for the buffered continuous analog
input, refer to Chapter 5: Continuous Data Transfer.
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One-Shot Analog Input

This section describes the function flow typical of non-buffered sin-
gle-point analog input readings. While performing one-shot Al
operation, most cards (except PCI-9118 Series cards) doesn't
need to include the Al configuration step at the beginning of the
application.

Al_9118_Config
(on PCI-9118 Series cards only)

YES
Voltage reading?

Al_ReadChannel Al_VReadChannel

YES

Another reading?

Example code fragment
card = Register_Card(PCl_9118, card_number);
Al_9118 Config(card, Input_Signal | Input_Mode,0,0,0);
Al_ReadChannel (card, channelNo, range,
&analog_input[i]);

Release_Card(card);
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Synchronous Continuous Analog Input

This section describes the function flow typical of synchronous
analog input operation. While performing continuous Al operation,
the Al configuration function has to be called at the beginning of
your application. In addition, for synchronous Al, the SyncMode
argument in continuous Al functions has to be set to SYNCH_OP.

AI_XXXX_Config
(XXXX = card type)

NO

YES Sample multiple
ontinuous channels?
With SyncMode
v =SYNCH_OP

With SyncMode
=SYNCH_OP A 4

Al_ContScanChannels/ Al_ContReadChannel/
Al_ContScanChannelsToFile Al_ContReadChannelToFile

Scale to voltage?

YES

Al_ContVScale

Example code fragment
card = Register_Card(PCl_9112, card_number);

Al_9112 Config(card, TRIG_INT_PACER);

Al_ContScanChannels (card, channel, range, ai_buf,
data_size, (F64)sample_rate, SYNCH OP); or

Al_ContReadChannel (card, channel, range, ai_buf,
data_size, (F64)sample_rate, SYNCH_OP)

Release_Card(card);
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Non-Trigger Non-double-buffered Asynchronous
Continuous Analog Input

This section describes the function flow typical of non-trigger, non-
double-buffered asynchronous analog input operation. While per-
forming continuous Al operation, the Al configuration function has
to be called at the beginning of your application. In addition, for
asynchronous Al, the SyncMode argument in continuous Al func-
tions has to be setto ASYNCH_OP.

Al_XXXX_Config
(XXXX = card type)

Sample multiple NO
ontinuous channels?
With SyncMode
= SYNCH_OP

Al_ContScanChannels/ Al_ContReadChannel/
Al_ContScanChannelsToFile Al_ContReadChannelToFile

»
L
A

With SyncMode
=SYNCH_OP

4

Al_AsyncCheck

Operation complete?

YES

Al_AsyncClear

!
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Examp

le code fragment
card = Register_Card(PCl_9112, card_number);

Al_9112 Config(card,TRIG_INT_PACER);
Al_AsyncDblBufferMode (card, 0); //non-double-buffer
Al
Al_ContScanChannels (card, channel, range, ai_buf,
data_size, (F64)sample_rate, ASYNCH_OP); or
Al_ContReadChannel (card, channel, range, ai_buf,
data_size, (F64)sample_rate, ASYNCH_OP)
do {
Al_AsyncCheck(card, &bStopped, &count);
} while (!bStopped);
Al_AsyncClear(card, &count);

Release_Card(card);
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Non-Trigger Double-buffered Asynchronous Continuous
Analog Input

This section describes the function flow typical of non-trigger, dou-
ble-buffered asynchronous analog input operation. While perform-
ing continuous Al operation, the Al configuration function has to be
called at the beginning of your application. For asynchronous Al,
The SyncMode argument in continuous Al functions has to be set
to ASYNCH_OP. In addition, double-buffered Al operation is
enabled by setting Enable argument of Al_AsyncDblBufferMode
function to 1. For more information on double buffer mode, refer to

section 5.2.

With SyncMode
= ASYNCH_OP

AI_XXXX_Config
(XXX = card type)

With SyncMode
= ASYNCH_OP

Al_ContScanChannels/
Al_ContScanChannelsToFile

Al_ContReadChannel/
Al_ContReadChannelToFile

Al_AsyncDblBuffer|
HalfReady

Next half buffer
ready for transfer?
YES
Al_AsyncDblBuffer|
Transfer

Do you want to
stop the operation?
YES
Al_AsyncClear
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Example code fragment

card = Register_Card(PCl_9112, card_number);

Al_9112 Config(card, TRIG_INT_PACER);
Al_AsyncDblBufferMode (card, 1); // Double-buffered
Al_ContScanChannels (card, channel, range, ai_buf,
data_size, (F64)sample_rate, ASYNCH_OP); or
Al_ContReadChannel (card, channel, range, ai_buf,
data_size, (F64)sample_rate, ASYNCH_OP)
do {
do {
Al_AsyncDblBufferHalfReady(card, &HalfReac
&fstop);
} while (MHalfReady);

Al_AsyncDblBufferTransfer(card, ai_buf);
} while (Iclear_op);
Al_AsyncClear(card, &count);

Release_Card(card);
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Trigger Mode Non-double-buffered Asynchronous
Continuous Analog Input

This section describes the function flow typical of trigger mode
double-buffered asynchronous analog input operation. A trigger is
an event that occurs based on a specified set of conditions. An
interrupt mode or DMA-mode Analog input operation can use a
trigger to determinate when acquisition stop. The trigger mode
data acquisition programming is almost the same as the non-trig-
ger mode asynchronous analog input programming. When using
PCIS-DASK to perform trigger mode data acquisition, the Sync-
Mode of continuous Al should be set to ASYNCH_OP.

With SyncMode
= ASYNCH_OP

YES

Al_XXXX_Config with
Trigger Mode enabled
(XXXX = card type)

A 4

With Enable = TRUE

Al_AsyncDblBufferMode

|

Sample multiple

A 4

NO

ontinuous channels?
With SyncMode
v =ASYNCH_OP

Al_ContScanChannels/
Al_ContScanChannelsToFile

Al_ContReadChannel/
Al_ContReadChannelToFile

»
L
A

A

Al_AsyncCheck

Operation
complete?

YES

Al_AsyncClear

!
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Examp

le code fragment
card = Register_Card(PCI_9118, card_number);

Al_9118 Config(card,

P9118 Al_BiPolar|P9118_Al_SingEnded,
P9118 Al_DtrgPositive|P9118 Al_EtrgPositive]|
P9118 Al_AboutTrgEn, 0, postCount)
Al_AsyncDblBufferMode (card, 0); //non-double-buffer

Al
Al_ContScanChannels (card, channel, range, ai_buf,

data_size, (F64)sample_rate, ASYNCH_OP); or
Al_ContReadChannel (card, channel, range, ai_buf,

data_size, (F64)sample_rate, ASYNCH_OP)

do {
Al_AsyncCheck(card, &bStopped, &count);
} while (!bStopped);

Al_AsyncClear(card, é&count);

Release_Card(card);
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Trigger Mode Double-buffered Asynchronous Continuous
Analog Input

This section describes the function flow typical of trigger mode
double-buffered asynchronous analog input operation. A trigger is
an event that occurs based on a specified set of conditions. An
interrupt mode or DMA-mode Analog input operation can use a
trigger to determinate when acquisition stop. The trigger mode
data acquisition programming is almost the same as the non-trig-
ger mode asynchronous analog input programming. When using
PCIS-DASK to perform trigger mode data acquisition, the Sync-
Mode of continuous Al should be set to ASYNCH_OP. In addition,
double-buffered Al operation is enabled by setting Enable argu-
ment of Al_AsyncDbIBufferMode function to 1. For more informa-
tion on double buffer mode, refer to section 5.2 for the details.
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Al_XXXX_Config with
Trigger Mode enabled
(XXXX = card type)

With Enable = TRUE

v
Al_AsyncDblBufferMode

YES NO

Sample multiple
ontinuous channels?

With SyncMode With SyncMode

=ASYNCH OP L 4 = ASYNCH_OP
Al_ContScanChannels/ Al_ContReadChannel/
Al_ContScanChannelsToFile Al_ContReadChannelToFile

v

Al_AsyncDblBuffer
HalfReady

NO

Next half buffer
ready for transfer? Or
Qperation complete

YES

Al_AsyncDblBuffer
Transfer

NO

Do you want to
stop the operation?

YES

Al_AsyncClear

!
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Example code fragment
card = Register_Card(PCl_9118, card_number);

Al_9118 Config(card,P9118 Al _BiPolar|P9118 Al_SingE
d,
P9118_Al_DtrgPositive|P9118 Al_EtrgPositive]|
P9118 Al _AboutTrgEn,O,postCount)
Al_AsyncDblBufferMode (card, 1); Double-buffered A
Al_ContScanChannels (card, channel, range, ai_buf,
data_size, (F64)sample_rate, ASYNCH_OP); or
Al_ContReadChannel (card, channel, range, ai_buf,
data_size, (F64)sample_rate, ASYNCH_OP)
do {
do {
Al_AsyncDblBufferHal fReady(card, &HalfReac
&fstop);
} while (!HalfReady && !fstop);

Al_AsyncDblBufferTransfer(card, ai_buf);
} while (Iclear_op && !fstop);

Al_AsyncClear(card, é&count);
Al_AsyncDblBufferTransfer(card, ai_buf);

Release_Card(card);
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4.2 Analog Output Programming Hints

The PCIS-DASK provides two kinds of analog output operations:
non-buffered single-point analog output operation and buffered
continuous analog output operation.

The non-buffered single-point AO uses software polling method
to write data to the device. The programming scheme for this kind
of AO operation is described in section 4.2.1.

The buffered continuous AO uses a DMA transfer method to
transfer data from user’s buffer to device. The maximum number
of count in one transfer depends on the size of initially allocated
memory for analog output in the driver. The driver allocates the
memory at Windows startup. We recommend that applications use
AOQO_InitialIMemoryAllocated function to get the size of initially allo-
cated memory before beginning to perform continuous AO opera-
tions.
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Single-point Analog Output Programming Scheme

This section described the function flow typical of non-buffered
single-point digital output operation. While performing one-shot
AO operation, the cards whose 1/O port can be set as input or out
put port need to include port configuration function at the begin-
ning of your application.

Example code fragment
card = _Register_Card(PCl_6202, card_number);

AO_WriteChannel(card, chan, out_value);

Release_Card(card);
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Continuous Analog Output (with initial default settings)
Programming Scheme

This section described the function flow typical of synchronous
analog output operation performed by the device with initial default
configuration. While performing continuous AO operation, the AO
configuration function has to be called at the beginning of your
application. In addition, the SyncMode argument in continuous AO
functions has to be set as ASYNCH_OP.

1. Non-double-buffered Asynchronous Continuous Analog
Output Programming Scheme

AOQ_ContBufferSetup

¢ With Swnehlode=ASYNCH_OP

AO_ContWritePort

>y

AO_AsyncCheck

Operation complete?

Yes

AO_AsyncClear

!
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Example code fragment
card = Register_Card(PCIl_6202, card_number);

AO_ContBufferSetup (card, ao_buf, data_size, &Dald)

AO_ContWriteChannel (card, 0, Dald, data_size,
iteration, samp_intrv, samp_intrv, ASYNCH_OP);;

do {

AO_AsyncCheck(card, &bStopped, &count);

} while (!bStopped);

AO_AsyncClear(card, &count, mode);

Release_Card(card);
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2. Double-buffered Asynchronous Continuous Analog Out-
put Programming Scheme

AU _ContButiersetup
AO”_ContBufferSetup

+ With Enable=TRUE

AO_AsyncDblBufferMode

ample multipte
continuous chan

e - With Synchlode

With SymcMods - -

SYNCH OPY W =ASYNCH_OP
AOD_ContWriteMultiChannels AO_CentWriteChanne

.
F

A
| AO_AsyncDblBufferHalfReady |

!

Next half buffer
Ready?

Placing the output data into the ready buffer ..

Want to stop
the operation?

=y

| AO_AsyncClear

\7
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Example code fragment

card = Register_Card(PCIl_6202, card_number);

AO_ContBufferSetup (card, ao buf, data_size, &Dald)

AO_ContBufferSetup (card, ao buf2, data_size, &Dald

AO_AsyncDblBufferMode (card, 1);

AO_ContWriteChannel(card, 0, Dald, data size, O,
samp_intrv, samp_intrv, ASYNCH_OP);;

do {

do {

AO_AsyncDblBufferHalfReady(card, &HalfReady);

} while ('HalfReady);

// Placing the output data into the ready buffer ..

} while (Iclear_op);
AO_AsyncClear(card, &count, mode);

Release_Card(card);
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4.3 Digital Input Programming Hints

The PCIS-DASK provides two types of digital input operation: non-
buffered single-point digital input operation and buffered continu-
ous digital input operation.

The non-buffered single-point DI uses software polling method to
read data from the device. The programming scheme for this kind
of DI operation is described in section .

The buffered continuous DI uses DMA transfer method to transfer
data from device to user's buffer. The maximum number of count
in one transfer depends on the size of initially allocated memory
for digital input in the driver. The driver allocates the memory at
system boot (in Windows® NT) or during Windows startup (in Win-
dows® 98). It is recommended that the applications use the
DI_InitiaIMemoryAllocated function to get the size of initially allo-
cated memory before performing continuous DI operation.

The buffered continuous analog input includes synchronous con-
tinuous DI, non-double-buffered asynchronous continuous DI and
double-buffered asynchronous continuous DI. These are
described in section to section section. For special consideration
and performance issues for the buffered continuous analog input,
refer to Chapter 5: Continuous Data Transfer.
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One-Shot Digital Input

This section describes the function flow typical of non-buffered sin-
gle-point digital input readings. While performing one-shot DI
operation, devices whose 1/0O port can be set as input or output
port (PCI-7248, PCI-7296, and PCI-7442) need to include port
configuration function at the beginning of the application.

PCIS-DASK

Digital Input Programming Hints

DIO_PortConfig

[only on PCI-7248, PCI-7249, PCI-7296 and PCI-7442 (TTL)]
DIO_LineConfig (only on PCI-7442 [TTL])
DIO_LinesConfig (only needed by PCI-7442 [TTL])

.

Y
NO

v

DI_ReadPort

Input data from line?

Line/Port configured
as input port

YES

h 4

DI_ReadLine

YES

NO

Example code fragments:

card = Register_Card(PCl_7248, card_number);

//port configured

DI0O_PortConfig(card ,Channel_P1A,
DIO_PortConfig(card, Channel_P1B,
DIO_PortConfig(card, Channel_P1CL,
DIO_PortConfig(card, Channel_P1CH,

//D1 operation

DI_ReadPort(card, Channel _P1A, &inputA);

Release_Card(card);

Another reading?

INPUT_PORT) ;

INPUT_PORT) ;
INPUT_PORT);
INPUT_PORT);
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card = Register_Card(PCl1_7442, card_number);
//1ine configured

DIO_LineConfig(card ,P7442_TTLO, 0, INPUT_LINE);
//DIl operation

DI_ReadlLinet(card, P7442_TTLO, O, &inDatalLine0);

Release_Card(card);
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Synchronous Continuous Digital Input

This section describes the function flow typical of synchronous
digital input operation. While performing continuous DI operation,
the DI configuration function has to be called at the beginning of
the application. For synchronous DI, the SyncMode argument in
continuous DI functions has to be set to SYNCH_OP.

DI_XXXX_Config
(XXXX = card type)

With SyncMode = SYNCH_OP

A 4

DI_ContReadPort /
DI_ContReadPortToFile

Example code fragment:
card = Register_Card(PCl_7200, card_number);

DI_7200_Config(card, TRIG_INT_PACER, DI_NOWAITING,
DI_TRIG_FALLING, IREQ_FALLING);

DI_AsyncDblBufferMode (card, 0); //non-double-buffer
mode

DI_ContReadPort(card, 0, pMem, data_ size,
(F64)sample_rate, SYNCH_OP)

Release_Card(card);
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Non-double-buffered Asynchronous Continuous Digital
Input

This section describes the function flow typical of non-double-buff-
ered asynchronous digital input operation. While performing con-
tinuous DI operation, the DI configuration function has to be called
at the beginning of the application. For asynchronous DI opera-
tion, the SyncMode argument in continuous DI functions has to be
set to ASYNCH_OP.

DI_XXXX_Config
(XXXX = card type)

With SyncMode = SYNCH_OP

v

DI_ContReadPort /
DI_ContReadPortToFile

»
»

A 4

DI_AsyncCheck

Operation
completed?

YES

DI_AsyncCheck
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Example code fragment:
card = Register_Card(PCl_7200, card_number);

DI_7200_Config(card,TRIG_INT_PACER, DI_NOWAITING,

DI_TRIG_FALLING, IREQ FALLING);
DI_AsyncDblBufferMode (card, 0); // non-double-

buffered mode
DI_ContReadPort(card, 0, pMem, data_size,

(F64)sample_rate, ASYNCH_OP)

do {
DI_AsyncCheck(card, &bStopped, &count);
} while (!bStopped);

DI_AsyncClear(card, &count);

Release_Card(card);

Application Hints 79



PCIS-DASK
Digital Input Programming Hints

Double-buffered Asynchronous Continuous Digital Input

This section describes the function flow typical of double-buffered
asynchronous digital input operation. While performing continuous
DI operation, the DI configuration function has to be called at the
beginning of the application. For asynchronous DI, the SyncMode
argument in continuous DI functions has to be set to
ASYNCH_OP. In addition, double-buffered DI operation is enabled
by setting Enable argument of DI_AsyncDblBufferMode function to
1. For more information on double buffer mode, refer to
section 5.2.

DI_XXXX_Config
(XXXX = card type)

With ENABLE = True

DIAsyncDblBufferMode

With SyncMode = SYNCH_OP

A

DI_ContReadPort/
DI_ContReadPortToFile

P

DI_AsyncDblBufferHalfReady

DI_AsyncClear
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Example code fragment:
card = Register_Card(PCI_7200, card_number);

DI_7200_Config(card, TRIG_INT_PACER, DI_NOWAITING,
DI_TRIG_FALLING, IREQ_FALLING);
DI_AsyncDblBufferMode (card, 1); // Double-buffered
mode
DI_ContReadPort(card, O, pMem, data_size,
(F64)sample_rate, ASYNCH_OP)
do {
do {
DI_AsyncDblBufferHalfReady(card,
&Hal fReady) ;
} while (!HalfReady);

DI_AsyncDblBufferTransfer(card, pMem);
} while (Iclear_op);
DI_AsyncClear(card, &count);

Release_Card(card);
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Multiple-buffered Asynchronous Continuous Digital Input

This section describes the function flow typical of multi-buffered
asynchronous digital input operation. While performing continuous
DI operation, the DI configuration function has to be called at the
beginning of the application. For asynchronous DI, the SyncMode
argument in continuous DI functions has to be set to
ASYNCH_OP.
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DI_XXXX_Config
(XXXX = card type)

DI_ContMultiBufferSetup repeatedly...

v

ContMultiBufferStart

»
L

v

DI_AsyncMultiBufferNextReady

YES

Next half buffer
ready?

Handling the ready data

Stop the operation?

DI_AsyncClear
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Example code fragment:
card = Register_Card(PCI_7300A RevB, card_number);

D1_7300B_Config(card, 16, TRIG_CLK_10MHZ,
P7300_WAIT_NO, P7300_TERM_ON, O, 1, 1);

//setting the DMA buffers repeatedly

DI_ContMultiBufferSetup (card, in_buf, data_size,
&Bufferid);

DI_ContMultiBufferSetup (card, in_buf, data_size,
&Bufferlid);

// start multi-buffered DI
DI_ContMultiBufferStart (card, 0, 1);

do {
do {
D1_AsyncDblBufferHal fReady(card,
&Hal fReady) ;

} while ('HalfReady);
//Handling the ready data
} while (Iclear_op);
DI_AsyncClear(card, &count);

Release_Card(card);
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4.4 Digital Output Programming Hints

The PCIS-DASK provides three types of digital output operation:
non-buffered single-point digital output operation, buffered contin-
uous digital output operation, and pattern generation.

The non-buffered single-point DO uses software polling method to
write data to the device. The programming scheme for this kind of
DO operation is described in section .

The buffered continuous DO uses DMA transfer method to trans-
fer data from user's buffer to device. The maximum number of
count in one transfer depends on the size of initially allocated
memory for digital output in the driver. The driver allocates the
memory during system boot (in Windows® NT) or Windows startup
(in Windows® 98). It is recommended that applications use
DO_InitialMemoryAllocated function to get the size of initially allo-
cated memory before performing continuous DO operation.

The buffered continuous digital output includes synchronous con-
tinuous DO and asynchronous continuous DO. These are
described in section and section . For special consideration and
performance issues for the buffered continuous analog input, refer
to Chapter 5: Continuous Data Transfer.

The Pattern Generation DO outputs digital data pattern repeatedly
at a predetermined rate. The programming scheme for this kind of
DO operation is described in section .
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One-Shot Digital Output

This section describes the function flow typical of non-buffered sin-
gle-point digital output operation. While performing one-shot DO
operation, the cards whose 1/O port can be set as input or output
port (PCI-7248, PCI7249, PCI-7296, and PCI-7442) need to
include port configuration function at the beginning of the applica-
tion.

DIO_PortConfig
[only on PCI-7248, PCI-7249, PCI-7296 and PCI-7442 (TTL)]
DIO_LineConfig (only on PCI-7442 [TTL])
DIO_LinesConfig (only needed by PCI-7442 [TTL])

P> Port configured
L as output port
b
NO YES
Output data to line?
A 4 A4
DI_WritePort DI_WriteLine

Another output?

NO

Example code fragments:
card = Register_Card(PCl_7248, card_number);
//port configured
DI0_PortConfig(card ,Channel_P1A, OUTPUT_PORT);
DIO_PortConfig(card, Channel_P1B, OUTPUT_PORT);
DI0O_PortConfig(card, Channel_P1CL, OUTPUT_PORT);
DI0O_PortConfig(card, Channel_P1CH, OUTPUT_PORT);
//D0 operation
DO_WritePort(card, Channel P1A, outA_value);

Release_Card(card);
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card = Register_Card(PCl_7442, card_number);
//Lines configured

DIO_LineConfig(card, P7442_TTLO, O, OUTPUT_LINE);
//D0 operation

DO_WriteLine(card, P7442_TTLO, 0O, out_value);

Release_Card(card);
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Synchronous Continuous Digital Output

This section describes the function flow typical of synchronous
digital output operation. While performing continuous DO opera-
tion, the DO configuration function has to be called at the begin-
ning of the application. In addition, the SyncMode argument in
continuous DO functions for synchronous mode has to be set to
SYNCH_OP.

DO_XXXX_Config
(XXXX = card type)

With SyncMode = SYNCH_OP

A 4

DO_ContWritePort

Example code fragment:
card = Register_Card(PCl_7200, card_number);

DO_7200_Config(card, TRIG_INT_PACER, OREQ DISABLE,
OTRIG_LOW);

DO_AsyncDblBufferMode (card, 0); //non-double-buffer
mode

DO_ContWritePort(card, 0, DoBuf, count, 1,
(F64)sample_rate, SYNCH_OP);

Release_Card(card);
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Asynchronous Continuous Digital Output

This section describes the function flow typical of asynchronous
digital output operation. While performing continuous DO opera-
tion, the DO configuration function has to be called at the begin-
ning of the application. In addition, the SyncMode argument in
continuous DO functions for asynchronous mode has to be set to
ASYNCH_OP.

DO_XXXX_Config
(XXXX = card type)

With SyncMode = SYNCH_OP

A

DO_ContWritePort

»

A

DO_AsyncCheck

.

Operation
completed?

DO_AsyncCheck

Example code fragment:
card = Register_Card(PCl_7200, card_number);

DO_7200_Config(card, TRIG_INT_PACER, OREQ DISABLE,
OTRIG_LOW) ;
DO_ContWritePort(card, 0, DoBuf, count, 1,
(F64)sample_rate, ASYNCH_OP);
do {
DO_AsyncCheck(card, &bStopped, &count);
} while (!bStopped);

DO_AsyncClear(card, &count);

Release_Card(card);
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Pattern Generation Digital Output

This section describes the function flow typical of pattern genera-
tion for digital output. While performing pattern generation of DO,
the DO configuration function has to be called at the beginning of
the application.

DI_XXXX_Config
(XXXX = card type)

A 4

DO_PGStart

Complete pattern generation

A 4

DO_PGStop

Example code fragment:
card = Register_Card(PCI_7300A _RevB, card_number);

DO_7300B_Config (card, 16, TRIG_INT_PACER,
P7300_WAIT_NO, P7300_TERM_ON, 0, 0x40004000);

//start pattern generation

DO_PGStart (card, out_buf, 10000, 5000000);

//stop pattern generation
DO_PGStop (card);
Release_Card(card);
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Multiple-buffered Asynchronous Continuous Digital
Output

This section describes the function flow typical of multi-buffered
asynchronous digital output operation. While performing continu-
ous DO operation, the DO configuration function has to be called
at the beginning of the application. For asynchronous DO, the
SyncMode argument in continuous DO functions has to be set as
ASYNCH_OP.

DO_XXXX_Config
(XXXX = card type)

v

DO_ContMultiBufferSetup repeatedly...

v

DO_ContMultiBufferStart

»

A 4

DO_AsyncMultiBufferNextReady

YES

Next half buffer
ready?

Copy prepared data to the ready buffer

Stop the operation?

YES

DO_AsyncClear
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Example code fragment:
card = Register_Card(PCI_7300A RevB, card_number);

DO_7300B_Config (card, 16, TRIG_CLK_10MHZ,
P7300_WAIT_NO, P7300_TERM_ON, O, 0x00040004);

//setting the DMA buffers repeatedly

DO_ContMultiBufferSetup (card, out buf, data_size,
&Bufferid);

DO_ContMultiBufferSetup (card, out buf, data_size,
&Bufferlid);

// start multi-buffered DO
DO_ContMultiBufferStart (card, 0, 1);

do {
do {
DO_AsyncDblIBufferHal fReady(card,
&Hal fReady) ;
} while ('HalfReady);
// Copy prepared data to the ready buffer
} while (Iclear_op);

DO_AsyncClear(card, &count);

Release_Card(card);

92 Application Hints



PCIS-DASK
DAQ Event Message Programming Hints

4.5 DAQ Event Message Programming Hints

DAQ Event Message functions are efficient ways to monitor your
background data acquisition processes without dedicating your
foreground process for status checking. There are two kinds of
events: Al/DI/DO operation completed notification event and half
buffer ready notification event.

To receive notification from the PCIS-DASK data acquisition pro-
cess in case of special events, you can call Al_EventCallBack,
DI_EventCallBack, or DO_EventCallBack to specify an event.

Event notification is done through user-defined callbacks. When a
user-specified DAQ event occurs, PCIS-DASK calls the user-
defined callback. After receiving the message, the user's applica-
tion carries out the appropriate task.

The event message mechanism is easy and safe in Windows® 98
and Windows® NT systems. However, the time delay between the
event and notification is highly variable and depends largely on
how your system is loaded. In addition, if a callback function is
called, succeeding events will not be handled until your callback
has returned. If the time interval between events is smaller than
the time taken for callback function processing, the succeeding
events will not be handled. Therefore this mechanism is not suit-
able for the frequent events occurrence condition.
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Example code fragment:
card = Register_Card(PCI_9118DG, card_number);
Al_9118 Config(card,P9118_Al_BiPolar|P9118_Al_SingE
d,
P9118_ Al_DtrgPositive|P9118 Al_EtrgPositive|P911¢
I_AboutTrgEn,0,postCount) ;
Al_AsyncDblBufferMode(card, 1); //double-buffer mo

// Enable half buffer ready event notification
Al_EventCallBack (card, 1, DBEvent, (U32]
DB_cbfn );

//Enable Al completeness event notification
Al_EventCallBack (card, 1, AIEnd, (U32) Al _cbfn );

Al_ContScanChannels (card, channel, range, NULL,
data_size, (F64)sample_rate, ASYNCH_OP); or

Al_ContReadChannel (card, channel, range, NULL,
data_size, (F64)sample_rate, ASYNCH_OP)

Release_Card(card);

//Half buffer ready call back function

void DB_cbfn()

{

//half buffer is ready

Al_AsyncDblBufferTransfer(card, ai_buf); //transfe
to user buffer

}.

//A1 completeness call back function

void Al_cbfn()

{

//Al is completed ]

Al_AsyncClear(card, é&count);

//Transfer the remainling data into the user buffer
Al_AsyncDblBufferTransfer(card, ai_buf);

i-

94 Application Hints



PCIS-DASK
Interrupt Event Message Programming Hints

4.6 Interrupt Event Message Programming Hints

The PCIS-DASK comes with two methods of performing interrupt
occurrence notification for NUDAQ DIO cards that have dual-inter-
rupt system.

The Event Message method handles event notification through
user-defined callbacks and/or the Windows Message queue (for
VB5, through user-defined callbacks only). When a user-specified
interrupt event occurs, PCIS-DASK calls the user-defined callback
(if defined) and/or puts a message into the Windows Message
gueue, if you specified a window handle. After receiving the mes-
sage, the user's application can carry out the appropriate task.

The event message mechanism is easy and safe in Windows® 98
and Windows® NT systems. However, the time delay between the
event and notification is highly variable and depends largely on
how your system is loaded. In addition, if a callback function is
called, succeeding events will not be handled until your callback
has returned. If the time interval between events is smaller than
the time taken for callback function processing, the succeeding
events will not be handled. Therefore this mechanism is not suit-
able for the frequent events occurrence condition.

The Event Status checking and waiting method handles interrupt
event status checking through Win32 wait functions, such as Wait-
ForSingleObject or WaitForMultipleObjects. This method is useful
for situations when the interrupt event occurs very often and when
the applications written in the language doesn't support function
pointers (e.g. VB4).
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Through user-defined callbacks and Windows Message
queue

Example code fragment:
card = Register_Card(PCl_7230, card_number);

//INT1 event notification is through window message
DIO_INT1_EventMessage (card, INT1_EXT_SIGNAL, hWnd,
WM_INT, NULL);

//INT2 event notification is through a callback
function

DIO_INT2_EventMessage (card, INT2_EXT_SIGNAL, hwWwnd,
NULL, (void *) cbfn);

//window message handling function
long PASCAL MainWndProc(hWnd, message, wParam,
IParam)

{

switch(message) {

case WM_INT: //interrupt event occurring message

break;

case WM_DESTROY:
//Disable interrupts
DIO_INT1 _EventMessage (card, INT1 DISABLE, hMainWr
NULL, NULL);
DIO_INT2_EventMessage (card, INT2_DISABLE, hMainWnd
NULL, NULL);
//Release card
if (card >= 0) Release_Card(card);
PostQuitMessage(0);
break;
b
}

//call back function
LRESULT CALLBACK cbfn(Q)

{
}
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Through a Win32 wait function

Example code fragment:

card = Register_Card(PCIl_7230, card_number);
DI10_SetDual Interrupt(card, INT1_EXT_SIGNAL,
INT2_EXT_SIGNAL, hEvent);

//wait for INT1 event

it (WaitForSingleObject(hEvent[0], INFINITE) ==
WAIT_OBJECT 0) {

ResetEvent(hEvent[0]);

//wait for [INT2 event

if (WaitForSingleObject(hEvent[1], INFINITE) ==
WAIT_OBJECT_0) {
ResetEvent(hEvent[1]);

if (card >= 0) Release_Card(card);
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5 Continuous Data Transfer

The continuous data transfer function in the PCIS-DASK inputs or
outputs blocks of data to or from a plugged-in NuDAQ PCI device.
For input operations, the PCIS-DASK transfers the incoming data
to a buffer in the system memory. For output operations, the PCIS-
DASK transfers outgoing data from a buffer in the computer mem-
ory to the NuDAQ PCI device.

This chapter describes the mechanism and techniques that PCIS-
DASK use for continuous data transfer and the considerations for
selecting the continuous data transfer mode (synchronous or
asynchronous, double buffered, triggered or non-triggered mode).

5.1 Mechanisms

The PCIS-DASK uses two mechanisms to perform continuous
data transfer: interrupt transfer and DMA.

Interrupt transfer transfers data through the interrupt mechanism,
while the DMA controller chip performs data transfer via a hard-
ware. The PCIS-DASK uses the interrupt or DMA depending on
the device. When the device supports both mechanisms, the
PCIS-DASK decides on the data transfer method that takes maxi-
mum advantage of available resources. For example, PCI-9112
supports both interrupt and DMA for data transfers. The PCIS-
DASK uses DMA data transfer in this instance since it is faster.
For PCI-9111 that supports FIFO Half-Full and EOC interrupt
transfer modes, the PCIS-DASK uses the FIFO Half-Full interrupt
transfer mode since the CPU is interrupted to do data transfer only
when the FIFO becomes half-full.
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5.2 Double-Buffered Al/DI Operation

The PCIS-DASK uses double-buffering techniques in its driver
software for continuous input of large amounts of data.

Double Buffer Mode Principle

The data buffer for double-buffered continuous input operation is a
logical circular buffer. It is logically divided into two equal halves.
The double-buffered input begins when the device starts writing
data into the first half of the circular buffer (a). Refer to figure
below. When the device starts writing to the second half of the cir-
cular buffer, the data is copied from the first half to the transfer
buffer (b) also known as user buffer. You can now process the
data in the transfer buffer depending on the application needs.
After the board has filled the second half of the circular buffer, the
board returns to the first half buffer and overwrites the old data.
The data is copied from the second half of the circular buffer to the
transfer buffer (c). The data in the transfer buffer is again available
for process. The process may be repeated endlessly to provide a
continuous stream of data to your application (d).

Eraming TIMA
ptine \l € il B

| [ ey [ weedmivn  [EE0] Tudmdon |

The PCIS-DASK double buffer mode functions were designed
according to the principle described above. If you use:

Al_AsyncDblBufferMode or
D1_AsyncDblIBufferMode

to enable double buffer mode, the following continuous Al/DI func-
tion performs double-buffered continuous Al/DI. You may call
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Al_AsyncDblBufferHalfReady or
DI_AsyncDblBufferHal fReady

to check if data in the circular buffer is half full and ready for copy-
ing to the transfer buffer. Then you may call:

Al_AsyncDblBufferTransfer or
DI_AsyncDblIBufferTransfer

to copy data from the ready half buffer to the transfer buffer.
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Single-Buffered Versus Double-Buffered Data Transfer

Single-buffered data transfer is the most common method for con-
tinuous data transfer. In single-buffered input operations, a fixed
number of samples are acquired at a specified rate and trans-
ferred into user's buffer. After the user's buffer stores the data, the
application can analyze, display, or store the data to the hard disk
for later processing. Single-buffered operations are relatively sim-
ple to implement and can usually take advantage of the full hard-
ware speed of the device. However, the major disadvantage of
single-buffered operation is that the maximum amount of data that
can be input at any one time is limited to the amount of initially
allocated memory allocated in driver and the amount of free mem-
ory available in the computer.

In double-buffered operations, as mentioned above, the data
buffer is configured as a circular buffer. Therefore, unlike single-
buffered operations, double-buffered operations reuse the same
buffer and are able to input or output an infinite number of data
points without requiring an infinite amount of memory. However,
there exists the undesired result of data overwritten for double-
buffered data transfer. The device might overwrite data before
PCIS-DASK has copied it to the transfer buffer. Another data over-
written problem occurs when an input device overwrites data that
PCIS-DASK is simultaneously copying to the transfer buffer.
Therefore, the data must be processed by the application at least
as fast as the rate at which the device is reading data. For most of
the applications, this requirement depends on the speed and effi-
ciency of the computer system and programming language.

Hence, double buffering might not be practical for high-speed
input applications.
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5.3 Trigger Mode Data Acquisition for Analog Input

A trigger is an event that occurs based on a specified set of condi-
tions. An interrupt mode or DMA-mode analog input operation can
use a trigger to determinate when acquisition stops or starts.

The PCIS-DASK also provides two buffering methods for trigger
mode Al double-buffering and single-buffering. However, the sin-
gle buffer in trigger mode Al is different from that in non-trigger
mode Al. It is a circular buffer just like that in double buffer mode
but the data stored in the buffer can be processed only when the
continuous data reading is completed. The buffer is reused until
the data acquisition operation is completed. Therefore, to keep the
data you want to transfer from being overwritten, the size of the
single buffer should be the same as or larger than the amount of
data you want to access.

For example, if you want to perform single-buffered middle-trigger
Al with PCI-9812, and the amount of data you want to collect
before and after the trigger event are 1000 and 3000, respectively,
the size of single buffer should be at least 4000. Since the data are
handled after the input operation is completed, data loss problems
are eliminated.

Since PCIS-DASK uses asynchronous Al to perform trigger mode
data acquisition, the SyncMode of continuous Al should be set as
ASYNCH_OP.

Continuous Data Transfer 103



104 Continuous Data Transfer



PCIS-DASK
Win32 Utilities

6 Utilities

This chapter introduces the tools that came with the PCIS-DASK
package.

6.1 Win32 Utilities

NuDAQ Registry/Configuration (PciUtil)

The PciUtil registers the PCIS-DASK drivers (Windows® NT4
only), removes installed drivers (Windows® NT4 only), and sets/
modifies the allocated buffer sizes of Al, AO, DI, and DO. By
default, the utility is located at <InstallDir>\Util directory.

Using PciUtil in Windows® NT

The PciUtil main window shows all registered PCIS-DASK/NT
drivers. When detected, PciUtil displays the driver in the Regis-
tered Drivers section.

3 NuDAQ-PCLAIFC-Co cfPCINT Driver Re

Exit!

This utility is used to make NuDAQ-PCY
NulPC-CompactPCI NT driver registry.

Registered Drivers :

[none) New...

To register a PCIS-DASK driver, click New.
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A Driver Configuration window appears.

Dnver Configuration E=
Card Type:

Buffer allocated [KB]:

4l |1u24
A0l |D
0} Iu

i) |u
Cancel |

From the Card Type drop-down menu, select the driver you want
to register, then key-in the allocated buffer (KB) for the Al, AO, DI,
or DO functions depending on your application requirements.

The allocated buffer represents the size of contiguous, initially
allocated memory for continuous analog input, analog output, digi-
tal input, and digital output. The device driver allocates the mem-
ory size during system startup. The size of initially allocated
memory is the maximum memory size that DMA or interrupt trans-
fer can be performed. An unexpected result occurs when the DMA
or interrupt transfer performs an operation exceeding the initially
allocated size.
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After setting the driver configuration, click OK to register the driver
and return to the PciUtil main window. The registered driver
appears on the registered driver list.

i NuDAR-PCI/NulPC-CompactPCl NT Driver ... =] E3

Exit!

This utility is used to make NuDAQ-PCI}
NulPC-CompactPCl NT driver registry.

Registered Drivers :

Pcidl18  New... |
Done |

To change the allocated buffer, select the driver from the Regis-
tered Driver list, then click Modify. The Driver Configuration win-
dow appears.

Driver Configuration E2
Card Type:

Buffer Allocated [KB):

4l |1t|24
) |D
0f: |u

[l Iu

Cancel |

Key-in the new allocated buffer size in each available Al, AO, DI
and DO fields, then click OK.

To remove a registered driver, select the driver from the Regis-
tered Driver list from the PciUtil main window, then click Remove.
The selected driver is deleted from the registry table.
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Using PciUtil in Windows® 98/2000/XP/Server 2003

The PciUtil sets or modifies the allocated buffer sizes of Al, AO,
DI and DO in Windows® 98/2000/XP/Server 2003 environment.

The allocated buffer represents the size of contiguous, initially
allocated memory for continuous analog input, analog output, digi-
tal input, and digital output. The device driver allocates the mem-
ory size during system startup. The size of initially allocated
memory is the maximum memory size that DMA or interrupt trans-
fer can be performed. An unexpected result occurs when the DMA
or interrupt transfer performs an operation exceeding the initially
allocated size.

To set the buffer size, key-in the allocated buffer (KB) for the Al,
AO, DI, or DO functions depending on your application require-
ments from the Driver Configuration window. Click OK when fin-
ished.

Driver Configuration E2
Card Type:
Buffer Allocated [KB):
e |1uz4
i |D
] |u
D) Iu
corel_|
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Data File Converter (DAQCvt)

When performing continuous data acquisition followed by storage
to a disk operation, the data files generated by the PCIS-DASK
functions are written in binary format. Normal text editors may not
be able to read binary files and spreadsheet applications may not
recognize binary files for analysis.

The PCIS-DASK comes with the DAQCvt tool to conveniently
convert these binary files into easily-read formats. The utility may
be found at <InstallDir>\Util directory.

The DAQCVvt main window is shown below.

@ ADLink DAQ File Convert Utility
~Input File
File Path: Browse |
Card Type AT Range
Channel number: Sean rate(Hz):
Humber of sean: Start date:
Diata wid th Start timne
Channel oxder: Channel/Range Tiew
Load
-~ Output File
Fil: Path | Browss |
Format: raled data to text file
Text File
Separator: (% Spece " Tab » ¥ Tifle/Head
Digital: % Decimsll ) Hexad enivne]
Btart Convert | About | Exit |

The DAQCvt main window is divided into two sections: Input File
and Output File. The Input File section identifies the source data
file while the Output File section identifies the destination for the
converted file.

To convert a binary file:
1. Click Browse to locate the binary file.

2. After locating the binary file, click Load. The binary file
information displays on the Input File section for your ref-
erence. The default converted data file path and format
also appear in the Output File section.
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NOTE

@ ADLink DAQ File Convert Utility

—Input File
File Path: [hpdaskird miSamples81 129091 1ZDbEFle'0112d dat | Browss

Card Type PCI 9112 AD Range +-5Y

Channel number; 4 Sean rateiHz): 500,000

Number of scam: 250 Start date: 104409

Data width: 16 hitz Start time 10:19:47 277
Channel oxder:  3-2-1-0 ChamnelRange: 0 e,

—Output File
Bil Paty  [Fedakwin e et O TECI T ZDbTLr01 (A vt || Browss
Fommat:  [Soaled data to tesc il =]
Text File
Separstor: (% Space " Tab - ¥ Title/Head
’7 Digital: % Decimsl €01 Hexad eoiisl

Start Convert | About | Exit |

The default destination for the converted file with a .cvt
extension is in the same directory as the source file.

3. To change the default file path, click Browse, then select
the destination for the converted file.

4,

To change the format of the converted file, click the For-
mat drop-down menu, then select from three available
data formats. Refer to the formats’ description below:

>

Scaled data to text file. The data in hexadecimal format
is scaled to engineering unit (voltage, ample, etc.)
according to the card type, data width, and data range,
then written to disk in text file format. This type is avail-
able for the data accessed from continuous Al operation
only.

Scaled data to binary file (float). The data in hexadeci-
mal is scaled to engineering unit (voltage, ample, etc.)
according to the card type, data width and data range,
then written to disk in binary file format. This type is
available for the data accessed from continuous Al oper-
ation only.
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> Binary codes to text file. The data in hexadecimal for-
mat or converted to a decimal value is written to disk in
text file format. If the original data includes channel infor-
mation, the raw value is handled to get the real data
value. This type is available for data accessed from con-
tinuous Al and DI operations.

5. Select the text file separator. You may separate data
using a space, a comma, or a tab.

6. Check the Title/Head option if you want to add a title/
head, including the card type information, at the begin-
ning of the file.

7. When finished, click Start Convert to convert the file.
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Sample Programs Browser

The PCIS-DASK comes with Examples.exe — a sample program
browser that allows you to view and execute all bundled sample
programs. Examples.exe is located at the <InstallDir>\Samples
directory. After launching Examples.exe, double-click the icon of
the sample you want to execute.

[ PCI-7206
[ PCI-73004 _Revi
[ PCI-73004 RevE
[ rcrms
[ PCI-T33
[ PCI-T434
[ PCI-8554
[ pcronn
[ PC10112
[ PCro113
[ PC10114

&

[ 9912VES

o SDE 981 2D biDelay Teg
L5 S DK 981 2DbiMid Trg
LS DK 981 2DbiPost Trg
L SDK981 2D biPre Trg
[ SDE981 2DelayTrg
LS DK981 2Mid Trg

[ S DE 981 2P0t Trg

[ SDE981 2Pre Trg

[ SDE 981 280t Trg

L] CO812File

L] CO812DbiFile

L YB9a12
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6.2 PCIS-DASK/X Utilities

This section introduces the tools that comes with the PCIS-DASK/
X package for Linux distributions.

dask_conf

The dask_conf configures the PCIS-DASK drivers, removes con-
figured drivers, and sets or modifies the allocated buffer sizes of
Al, AO, DI and DO. By default, the dask conf is located at pci-
dask_xxx/util (where xxx is the version number) directory.

Using dask_conf in Linux

The dask_conf main screen shows all configured PCIS-DASK/X
drivers in the Configured Cards list.

================== Configured Cards ====ss==============

Card Type  Cards Buffer Size [unit: pages(4KB/paged]
Al Al oI o
FCI&208 1 o 0 o 0
PCIE308 2 o 0 o 0
FCIF200 3 o 0 o 0

CLAPCIGE208 CZ23PCIE30E (IdPCIZF200 (42PCI7230 (GB2PCIVEIE

CEIPCIZ234 (7aPCIZ248 (8PCIZ249 (92PCIV2EQ (10)PCI7252

CLLdPCIZ296 CL2OPCIF432 (AZIPCIT43E C140PCIV434 (1BXPCISLL1
Select the card type for configuration. or 707 to ewiti]]

To configure a PCIS-DASK/X driver, type the card type number. A
Driver Configuration screen appears.

bttt DASK LIMWE Configuration Ubility BN

Card_Type i PCI9i11

How many PCI9111 adapters in your machine 3§ 1
Hemory pages for Al function ¢ 1 Hem_Page =

From this screen, key-in the number of cards and buffer size for
continuous operations. To be platform-independent, the buffer size
is set by the memory-page. The PAGE_SIZE for Intel platform is 4
KB. The Memory Pages of Al, AO, DI, and DO represent the
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number of pages of contiguous initially allocated memory for con-
tinuous analog input, analog output, digital input, and digital out-
put. The device driver allocates these memory sizes from the
memory management module.

After the selected driver is configured, type Y to confirm and return
to the dask_conf main screen. The configured driver now appears
at the Configured Cards list.

================== Configured Cards ss==s==ss==s==s====

Card Type  Cards Buffer Size [uniti pages(4kBpagel]
AL AD I o
FCIGZOS 1 ) o 0 o
PCIEZ0S 2 0 0 0 0
PCL7200 3 Q Q G Q
FCI9111 1 4 Q Q Q

CLIPCIGZ02 (ZHPCIEZ0OE (IHPCITEOR (4IPCIFEZI0 (DIPCITEER

CEIPCIT234 (TOPCIF24S (SOPCITZ49 (2OPCITEE0 (10OPCIFEGE

CI1MPCIZ296 (A2)PCIF432 (130PCIT4ZE3E (14)PCI7434 (1RIPCIFLILL
Select the card type for configuration, or 707 to exiti]

To modify the driver configuration, including the number of cards
and the buffer size, select the driver from the list, then assign the
new settings. When the number of cards is set to zero, the config-
uration for the selected driver is removed.

baiacaiaind DASK LIMUK Configuration Utility P

Card_Ture : PCIT111

How mahy PCI9111 adapters in your machine § O
Memory pages for Al function ¢ 1 Mem_Fage = ¢ KB » § O

The zetting for PCIF111

Al$0 Pages AOD:O Pages DIfd Pages D039 Pages for ¢ PCIZ111 Cards

## The Cards for FCI9L11 is zero, that will remowve PCIS11L s
## from configuration list, w3

are these correct VAH) T

When configuration is finished, the device configuration informa-
tion is saved in pci-dask_xxx/drivers/pcidask.conf. The content of
dask.conf is shown on the following illustration.
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= Configured Cards = =
Buffer Size [uniti pages(4kBApagel]
jin]

Al

PCIS-DASK

PCIS-DASK/X Utilities

Al
FCI&Z202 1 ]
FLCIE30S z ]
PCIF200 3 4]
PCIZ111 1 4

LsRefelel
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6.3 Module Installation Script

The PCI-bus architecture allows automatic detection of PCI
devices right after these are installed and device nodes are cre-
ated.

The following commands are necessary:

“insmod p9111~

“grep"p9111* /proc/devices”
“mknod /dev/PCI19111W0 c 254 0~
“mknod /dev/PCI19111W1 c 254 1”..

You can do these commands manually or use the provided instal-
lation scripts. The installation script is located at pci-dask_xxx/driv-
ers.

Using the pcidask.conf configuration file, the installation script
inserts all previously configured device modules and the memory
management module, if required. The script then makes device
nodes according to the number of cards. To install, execute this
script:

<InstalIDir>/pci-dask_xxx/drivers/dask_inst.pl

By default, the installation script reads the configuration file in the
current directory. You may specify the work directory for the PCIS-
DASKI/X to install script from the command argument. For exam-
ple, if the pcis-dask/x had been installed in /usr/local/pdask, you
may install the driver using the following command:

dask_inst_pl /usr/local/pdask

The installation script reads the related configuration file by its
argument and inserts the modules needed by the configured
devices. This may be useful if the installation needs to be exe-
cuted by init after system starts up.

For example, if you install the PCIS-DASK/X in the /usr/pdask
directory and the system needs to insert the modules automati-
cally. You may add the following command in the /etc/inittab, then
the init process inserts the modules automatically.

ad:2345:wait:/usr/pdask/drivers/dask_inst.pl 7/
usr/pdask "Insert ADLINK modules"
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Because the current modules are designed based on Uni-Proces-
sor kernel, these modules may not work with SMP kernel. The
installation script checks the kernel version through the /proc/sys/
kernel/version file. For SMP kernel, the version-checking proce-
dure displays the additional error/warning messages and stops the
installation.
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The dask_remove.pl removes the PCIS-DASK/X installed in Linux.
By default, this script is located at pci-dask_xxx/util directory.

To remove the PCIS-DASK for Linux, execute the uninstallation
script:

<InstalIDir>/pci-dask_xxx/util/dask_remove.pl

The script removes the device nodes made in /dev and the library
copied into /ust/lib.

6.5 Data File Converter (DAQCvt)

When performing continuous data acquisition followed by storage
to a disk operation, the data files generated by the PCIS-DASK
functions are written in binary format. Normal text editors may not
be able to read binary files and spreadsheet applications may not
recognize binary files for analysis.

The PCIS-DASK comes with the DAQCvt tool to conveniently
convert these binary files into easily-read formats. The utility may
be found at <InstallDir>\Util directory.

DAQCvt may be launched using the "--help" argument. The
DAQCvt main screen is shown below.

£28 root@localhost.localdomain: fimpiutilsrc <4

% File Sessions Options Help

Usage: DARCYE input_file [-stl-sbl-bt] [-sepldl-sepll-sep2] [—nohe_ﬂ
ad] output_file
imput_file : input file name

[-stl-shl-bt] : option For conwversion format
—=t. t text file with scaled data
—sh ; binary file with scaled data
-t ¢ text file with binary codes
default @ —st

[-=ep0l-sepll-sep2] § option for separator in Text File
—zepl 1 add SPACE s= separator
—szepl ¢ add TAB a= separator
—zep2 ¢ add COMMA &= separator
default ; —sepl

[-dec|-hex] ; option for separator in Text File
—dec : conwert to decimal value
—hex ¢ corwert to hexadecimal value
default  —dec
[-nohead] : option for ignore TitleHead

output_file ¢ output file name

[rootBlocalhost utilsrcl# [l -
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Options for data format conversion

DAQCuvt provides three data format options.
-st : text file with scaled data

The data in hexadecimal format is scaled to engineering unit (volt-
age, ample, etc.) according to the card type, data width, and data
range, then written to disk in text file format. This type is available
for the data accessed from continuous Al operation only.

-sb : binary file with scaled data (float)

The data in hexadecimal is scaled to engineering unit (voltage,
ample, etc.) according to the card type, data width and data range,
then written to disk in binary file format. This type is available for
the data accessed from continuous Al operation only.

-bt : text file with binary codes

The data in hexadecimal format or converted to a decimal value is
written to disk in text file format. If the original data includes chan-
nel information, the raw value is handled to get the real data value.
This type is available for data accessed from continuous Al and DI
operations.

The default option for data format conversion is -st.

Options for separator in text file

The data separator in the converted text file may either be a
space, tab, or comma.

-sep0 : add space as separator
-sepl : add Tab as separator
-sep2 : add comma as separator

The default option for data format conversion is -sep0.

Options for Title/Head in text file

If you do not want to add the title/head at the beginning of the file,
add the -nohead option.

After specifying the input filename, output filename, and the
options in the command line, DAQCvt converts the file and saves
it into the default location.
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7 Sample Programs

Several sample programs are provided in the software CD. These
sample program are designed to assist you when creating your
own applications using PCIS-DASK.

NOTE

ADLINK periodically upgrades the PCIS-DASK for new
cards/modules. Check the card/modules’s Release
Notes to know if PCIS-DASK supports it.

7.1 Brief Program Descriptions

Below is a list of programs and their description.

Card Type Sample Name Description
£6202A0 SSI Source D{A Continuous Conversion with SSI signal out
- = Visual C++ Program
D/A Continuous Conversion with SSI signal in
C6202A0_SS1_Target Visual C++ Program
C6202A0D0ub leBuffer D{A Continuous Conversion in double buffer mode
Visual C++ Program
- D/A Continuous Conversion
C6202A0SingleBuffer Visual C++ Program
PCI-6202 10 Pol
olling
€6202D10 Visual C++ Program
Encoder with Encoder Position Trigger
C6202Encoder Visual C++ Program
General Purpose Timer/Counter
C6202GPTC Visual C++ Program
- D/A Polling
CAOOnePoint Visual C++ Program
D/A conversion of PCI-6208V/16V
SbK6208v Visual C/C++ Program
D/A conversion of PCI-6208A
SDK6208A Visual C/C++ Program
PCI-6208 -
VB6208 D{A conversion of PCI-6208A
Visual Basic Program
VB6216 D{A conversion of PCI-6208V/16V
Visual Basic Program
D/A conversion of PCI-6308V
SDK6308V Visual C/C++ Program
D/A conversion of PCI-6308A
SDKE308A Visual C/C++ Program
PCI-6308 :
VB6308A D{A conversion of PCI-6308A
Visual Basic Program
VB6308Y D/A conversion of PCI-6308V

Visual Basic Program

Sample Programs
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Card Type

Sample Name

Description

PCI-7200

C7200File

1. Digital input of PCI-7200/cPCI-7200 through DMA transfer
2.  Storing the data to disk
Visual C/C++ console Program

C7200DbfFile

1. Double buffer mode digital input of PCI-7200/
cPCI-7200 through DMA transfer

2. Storing the data to disk

Visual C/C++ console Program

SDK7200Wave

Digital input of PCI-7200/cPCI-7200 through DMA transfer Visual C/
C++ Program

SDK7200DbfWav

Double buffer mode digital input of PCI-7200/cPCI-7200 through DMA
transfer Visual C/C++ Program

SDK7200HdSk

HandShanking mode digital input of PCI-7200/cPCI-7200 through
DMA transfer Visual C/C++ program

SDKETrigLine

ExtTrig Line setting of PCI-7200/cPCI-7200
Visual C/C++ Program

VB7200Dma

Digital input of PCI-7200/cPCI-7200 through DMA transfer Visual
Basic Program

PCI-7230

SDK7230

D/1, and D/O of PCI-7230/cPCI-7230
Visual C/C++ Program

SDK72301Int

D/I, and D/O of PCI-7230/cPCI-7230 by Interrupt Event Status
checking and waiting method
Visual C/C++ Program

SDK7230DbEvt

D/1, and D/O of PCI-7230/cPCI-7230 by Interrupt Event Status
checking and waiting method (Dual Interrupt Events) Visual C/C++
Program

SDK72301ntMsg

D/1, and D/O of PCI-7230/cPCI-7230 by Interrupt Event Message
method

SDK7230DbEvtMsg

D/1, and D/O of PCI-7230/cPCI-7230 by Interrupt Event Message
method (Dual Interrupt Events)
Visual C/C++ Program

VB7230

D/1, and D/O of PCI-7230/cPCI-7230
Visual Basic Program

PCI-7233

SDK7233

D/l of PCI-7233
Visual C/C++ Program

SDK7233Int

D/1 of PCI-7233 by Interrupt Event Status checking and waiting
method
Visual C/C++ Program

SDK7233DbEvt

D/l of PCI-7233 by Interrupt Event Status checking and waiting
method (Dual Interrupt Events)
Visual C/C++ Program

VB7233

D/l of PCI-7233
Visual Basic Program

PCI-7234

SDK7234

D/O of PCI-7234
Visual C/C++ Program

VB7234

D/O of PCI-7234
Visual Basic Program
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Card Type Sample Name Description
D/l, and D/O of PCI-7248/cPCl-7248
SDK7248 Visual C/C++ Program
D/1, and D/O of PCI-7248/cPCI-7248 by Interrupt Event Status
SDK72481nt checking and waiting method
Visual C/C++ Program
D/I, and D/O of PCI-7248/cPCI-7248 by Interrupt Event Status
SDK7248DbEvt checking and waiting method (Dual Interrupt Events) Visual C/C++
Program
PCI-7248
D/I, and D/O of PCI-7248/cPCI-7248 by Interrupt Event Message
SDK7248IntMsg method
Visual C/C++ Program
D/I, and D/O of PCI-7248/cPCI-7248 by Interrupt Event Message
SDK7248DbEvtMsg method (Dual Interrupt Events)
Visual C/C++ Program
VB7248 D/I, and D/O of PCI-7248/cPCI-7248
Visual Basic Program
D/I, and D/O of cPCI-7249
SDK7249 Visual C/C++ Program
D/1, and D/O of cPCI-7249 by Interrupt Event Status checking and
SDK72491nt waiting method
PCI-7249 Visual C/C++ Program
D/1, and D/O of cPCI-7249 by Interrupt Event Status checking and
SDK7249DbEvE waiting method (Dual Interrupt Events) Visual C/C++ Program
VB7249 D_II, and D/Q of cPCI-7249
Visual Basic Program
D/1, and D/O of PCI-7250/51
SDK7250 Visual C/C++ Program
PCI-7250
VB7250 D_II, and D/Q of PCI-7250/51
Visual Basic Program
D/1, and D/O of cPCI-7252
SDK7252 Visual C/C++ Program
PCI-7252
VB7252 D_II, and D/Q of cPCI-7252
Visual Basic Program
D/1, and D/O of PCI-7256
SDK7256 Visual C/C++ Program
D/1, and D/O of PCI-7256 by Interrupt Event Status checking and
SDK72561nt waiting method
PCI-7256 Visual C/C++ Program
D/1, and D/O of PCI-7256 by Interrupt Event Status checking and
SDK7256DbEVE waiting method (Dual Interrupt Events) Visual C/C++ Program
VB7256 D/I, and D/O of PCI-7256

Visual Basic Program

Sample Programs
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Card Type Sample Name Description
D/I, and D/O of PCI-7296
SDK7296 Visual C/C++ sample program
D/1, and D/O of PCI-7296 by Interrupt Event Status checking and
SDK7296Int waiting method
Visual C/C++ sample program
D/I, and D/O of PCI-7296 by Interrupt Event Status checking and
PCI-7296 SDK7296DbEVE waiting method (Dual Interrupt Events) Visual C/C++ sample program
D/I, and D/O of PCI-7296 by Interrupt Event Message method
SDK72481ntNsg Visual C/C++ Program
D/I, and D/O of PCI-7296 by Interrupt Event Message method (Dual
SDK7248DbEvtMsg Interrupt Events)
Visual C/C++ Program
VB7296 D_/I, and D/Q of PCI-7296
Visual Basic Program
Digital input of PCI-7300A_Rev.A/cPCI-7300A_Rev.A through DMA
SDK7300Wave transfer
Visual C/C++ Program
Pattern generation of PCI-7300A_Rev.A/cPCI-7300A_Rev.A
S7300PGwav Visual C/C++ program
Multiple buffer mode digital input of PCI-7300A_Rev.A/cPCI-
SDK7300aMBufWav 7300A_Rev.A through DMA transfer
Visual C/C++ sample program
PCI-7300 Interrupt operation of PCI-7300A_Rev.A/cPCI-7300A_Rev.A by Event
SDK73001Int Status checking and waiting method
Rev.A h
Visual C/C++ program
Interrupt operation of PCI-7300A_Rev.A/cPCI-7300A_Rev.A by
SDK7300DbEVE Interrupt Event Status checking and waiting method (Dual Interrupt
Events)
Visual C/C++ Program
1. Digital input of PCI-7300A_Rev.A/
- cPCI-7300A_Rev.A through DMA transfer
C7300File 2. Storing the data to disk
Visual C/C++ console program
Digital input of PCI-7300A_Rev.B/cPCI-7300A_Rev.B through DMA
SDK7300Wave transfer
Visual C/C++ Program
S7300PGwWav P_attern generation of PCI-7300A_Rev.B/cPCI-7300A_Rev.B
Visual C/C++ program
Multiple buffer mode digital input of PCI-7300A_Rev.B/cPCI-
SDK7300aMBufWav 7300A_Rev.B through DMA transfer
Visual C/C++ Program
Interrupt operation of PCI-7300A_Rev.B/cPCI-7300A_Rev.B by Event
SDK73001Int Status checking and waiting method
PCI-7300 Visual C/C++ program
Rev.B Interrupt operation of PCI-7300A_Rev.B/cPCI-7300A_Rev.B by
SDK7300DbEVE Interrupt Event Status checking and waiting method (Dual Interrupt
Events)
Visual C/C++ sample program
Double buffer mode digital output of PCI-7300A_Rev.B/cPCI-
C7300bDbfDO 7300A_Rev.B through DMA transfer
Visual C/C++ console Program
1. Digital input of PCI-7300A_Rev.B/cPCI-7300A_Rev.B through
- DMA transfer
C7300File 2. Storing the data to disk
Visual C/C++ sample program
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Card Type Sample Name Description
C7350 DI DMA Digital input of PCle-7350 through DMA transfer. Visual C/C++ Pro-
- = gram.
C7350 DI DMA File Digital input of PCle-7350 through DMA transfer. Visual C/C++ Pro-
— == gram.
- Digital input of PCle-7350 through DMA transfer with soft trigger.
C7350_DI_DMA_SoftTrig Vigual C/FZ:++ Program. o %
- Digital input of PCle-7350 through DMA transfer with external trigger.
C7350_DI_DWA_ExtTrig Visual C/C++ Program.
- Digital input of PCle-7350 through DMA transfer with external retrig-
C7350_DI_DMA_ExtReTrig ger. Visual C/C++ Program.
C7350_DI_DMA_ExtReTrig_Event Dlgltal_ input of PCle-7350 through DMA transfer with external retrig-
ger. Visual C/C++ Program.
- Digital input of PCle-7350 through DMA transfer with infinite retrigger.
C7350_DI_DMA_ExtInfTrig Visual C/C++ Program.
Digital input of PCle-7350 through DMA transfer with external sampled
C7350_D1_DWA_ExtCIk clock. Visual C/C++ Program.
Continuous digital input of PCle-7350 through DMA transfer with multi-
C7350_DI_MBF_Overrun buffers. Visual C/C++ Program.
Continuous digital input of PCle-7350 through DMA transfer with multi-
C7350_DI1_MBF_Event buffers. Visual C/C++ Program.
C7350 DO DMA Digital output of PCle-7350 through DMA transfer. Visual C/C++ Pro-
- = gram.
- Digital output of PCle-7350 through DMA transfer with soft trigger.
C7350_DO_DMA_SoftTrig Visual C/C++ Program.
PCle-7350 C7350_DO_DMA_ExtTrig Digital output of PCle-7350 through DMA transfer with external trigger.

Visual C/C++ Program.

C7350_DO_DMA_ExtReTrig

Digital output of PCle-7350 through DMA transfer with external retrig-
ger. Visual C/C++ Program.

C7350_DO_DMA_ExtReTrig_Event

Digital output of PCle-7350 through DMA transfer with external retrig-
ger. Visual C/C++ Program.

C7350_DO_DMA_ExtInfTrig_Event

Digital output of PCle-7350 through DMA transfer with infinite retrig-
ger. Visual C/C++ Program.

C7350_DO_DMA_ExtClk

Digital output of PCle-7350 through DMA transfer with external sam-
pled clock. Visual C/C++ Program.

C7350_DO_MBF

Continuous digital output of PCle-7350 through DMA transfer with
multi-buffers. Visual C/C++ Program.

C7350_DO_MBF_Event

Continuous digital output of PCle-7350 through DMA transfer with
multi-buffers. Visual C/C++ Program.

C7350_DI0_POLL

Digital input and output of PCle-7350 with polling mode. Visual C/C++
Program.

C7350_D10_HandShake

Digital input and output of PCle-7350 through DMA transfer with hand
shake mode. Visual C/C++ Program.

C7350_D10_BurstHandShake

Digital input and output of PCle-7350 through DMA transfer with burst
hand shake mode. Visual C/C++ Program.

C7350_C0s

Change of state of PCle-7350. Visual C/C++ Program.

C7350_PM_Level

Pattern match of PCle-7350. Visual C/C++ Program.

C7350_PM_Edge

Pattern match of PCle-7350. Visual C/C++ Program.

C7350_12C

Inter-Integrated Circuit of PCle-7350. Visual C/C++ Program.

C7350_SPI

Serial Peripheral Interface of PCle-7350. Visual C/C++ Program.

Sample Programs
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Card Type Sample Name Description

D/I, and D/O of PCI-7348

SDK7348 Visual C/C++ sample program

D/1, and D/O of PCI-7348 by Interrupt Event Status checking and
SDK7348Int waiting method
Visual C/C++ Program

D/I, and D/O of PCI-7348 by Interrupt Event Status checking and

SDK7348DbEVE waiting method (Dual Interrupt Events) Visual C/C++ Program

COS of Interrup operation of D/I, and D/O of PCI-7348 by Interrupt
SDK7348CO0Si Event Status checking and waiting method
Visual C/C++ sample program

D/I, and D/O of PCI-7348 by Interrupt Event Message method

SDK73481ntlisg Visual C/C++ Program

D/I, and D/O of PCI- PCI-7348 by Interrupt Event Message method
SDK7348DbEvtMsg (Dual Interrupt Events)
Visual C/C++ Program

D/I, and D/O of PCI-7348

VB7348 Visual Basic Program

PCI-7348

PCI-7396 D/I, and D/O of PCI-7396
SDK7396 Visual C/C++ sample program

D/I, and D/O of PCI-7396 by Interrupt Event Status checking and
SDK73961Int waiting method
Visual C/C++ Program

D/1, and D/O of PCI-7396 by Interrupt Event Status checking and

SDK7396DbEVE waiting method (Dual Interrupt Events) Visual C/C++ sample program

COS of Interrup operation of D/I, and D/O of PCI-7396 by Interrupt
SDK7396C0Si Event Status checking and waiting method
Visual C/C++ Program

D/1, and D/O of PCI-7396 by Interrupt Event Message method

SDK7396Intisg Visual C/C++ Program

D/1, and D/O of PCI- PCI-7396 by Interrupt Event Message method
SDK7396DbEvtMsg (Dual Interrupt Events)
Visual C/C++ Program

D/I, and D/O of PCI-7396

VB7396 Visual Basic Program

D/I, and D/O of PCI-7432/cPCI-7432

SDK7432 Visual C/C++ sample program

D/1, and D/O of PCI-7432/cPCI-7432 by Interrupt Event Status
SDK74321Int checking and waiting method
Visual C/C++ Program

D/I, and D/O of PCI-7432/cPCI-7432 by Interrupt Event Status
SDK7432DbEvt checking and waiting method (Dual Interrupt Events)
Visual C/C++ Program

PCI-7432

D/I, and D/O of PCI-7432/cPCI-7432 by Interrupt Event Message
SDK74321ntMsg method
Visual C/C++ Program

D/l, and D/O of PCI-7432/cPCI-7432 by Interrupt Event Message
SDK7432DbEvtMsg method (Dual Interrupt Events)
Visual C/C++ Program

D/I, and D/O of PCI-7432/cPCI-7433

VB7432 Visual Basic Program
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Card Type Sample Name Description
D/l of PCI-7433/cPCI-7433
SDK7433 Visual C/C++ sample program
D/l of cPCI-7433R
SDK7433R Visual C/C++ sample program
SDK74331nt E:‘I:Jgfr:rgl»7433/cPCI»7433 through Interrupt operation Visual C/C++
D/1 of PCI-7433/cPCI-7433 through Interrupt operation (Dual Interrupt
SDK7433DbEvt Events)
PCI-7433 Visual C/C++ Program
D/l of PCI-7433/cPCI-7433 by Interrupt Event Message method
SDK74331Inthsg Visual C/C++ Program
D/l of PCI-7433/cPCI-7433 by Interrupt Event Message method (Dual
SDK7433DbEvtMsg Interrupt Events)
Visual C/C++ Program
VB7433 D/l of PCI-7433/cPCI-7433
Visual Basic Program
D/O of PCI-7434/cPCI-7434
SDK7434 Visual C/C++ sample program
D/O of cPCI-7434R
PCI-7434 SDK7434R Visual C/C++ sample program
VB7434 D/O of PCI-7434/cPCI-7434
Visual Basic Program
- Programmable D/I and D/O of PCI-7442
C7442TTL_Line Visual C/C++ Program
Programmable D/I and D/O of PCI-7442
C7442TTL_Port Visual C/C++ Program
R D/l and D/O of PCI-7442
CD100nePoint Visual C/C++ Program
Watchdog timer of PCI-7442
CudtovTiow Visual C/C++ Program
Change-of-state of PCI-7442
SDK7442DbEvE Visual C/C++ Program
Change-of-state of PCI-7442
SDK7442DBEVEisg Visual C/C++ Program
- Change-of-state of PCI-7442
PCI-7442 SDK7442int Visual C/C++ Program
- Change-of-state of PCI-7442
SDK74421ntisg Visual C/C++ Program
Programmable D/I and D/O of PCI-7442
SDK7442TTL Visual C/C++ Program
D/l and D/O of PCI-7442
SDK7442D10 Visual C/C++ Program
Watchdog Timer of PCI-7442
SDKWdtOvTlow Visual C/C++ Program
VB7442TTL Programmable D/I and D/O of PCI-7442
Visual Basic Program
VB7442D10 D/l and D/O of PCI-7442
Visual Basic Program
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Card Type Sample Name Description

Programmable D/l and D/O of PCI-7443

C7443TTL_Line Visual C/C++ Program

Programmable D/l and D/O of PCI-7443

C7443TTL_Port Visual C/C++ Program

D/l of PCI-7443

CDIOnePoint Visual C/C++ Program

Change-of-state of PCI-7443

SDK7443intNsg Visual C/C++ Program
PCI-7443 Ch f-state of PCI-7443
R ange-of-state o -
SDK7443MultiEvE Visual C/C++ Program
- Change-of-state of PCI-7443
SDK7443Mul tiEvtMsg Visual C/C++ Program
Programmable D/l and D/O of PCI-7443
SDK7443TTL Visual C/C++ Program
VB7443TTL Programmable D/l and D/O of PCI-7443

Visual C/C++ Program

Programmable D/l and D/O of PCI-7444

C7444TTL Line Visual C/C++ Program

Programmable D/l and D/O of PCI-7444

C7444TTL_Port Visual C/C++ Program

D/O of PCI-7444

CDOOnePoint Visual C/C++ Program

Watchdog timer of PCI-7444
PCI-7444 cwdtovflow Visual C/C++ Program

Programmable D/l and D/O of PCI-7444

SDK7444TTL Visual C/C++ Program
Watch-dog Timer of PCI-7444
SDKWdtOvTlow Visual C/C++ Program
VB7444TTL P_rogramm_able D/l and D/O of PCI-7444
Visual Basic Program
Timer/counter of PCI-8554
SDK8554 Visual C/C++ sample program
Event counter of PCI-8554
PCI-8554 SDKEventcnt Visual C/C++ sample program
VB8554 Timer/counter of PCI-8554

Visual Basic Program
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Card Type

Sample Name

Description

PCI-9111

SDK9111

A/D conversion, D/A conversion, D/I, and D/O of PCI9111 Visual C/
C++ Program

SDK9111Int

Analog input of PCI-9111 through Interrupt operation Visual C/C++
Program

SDK9111DbfPreTrg

Pre-trigger with Double buffer mode analog input of PCI-9111 through
Interrupt operation
Visual C/C++ Program

SDK9111SpreTrg

Pre-trigger with Double buffer mode analog input of PCI-9111 through
Interrupt operation
Visual C/C++ Program

C9l11File

1. Analog input of PCI-9111 through Interrupt operation
2.  Storing the data to disk
Visual C/C++ console Program

C9111DbfFile

1. Double buffer mode analog input of PCI-9111 through Interrupt
operation

2. Storing the data to disk

Visual C/C++ console Program

VB9111

A/D conversion, D/A conversion, D/I, and D/O of PCI9111 Visual Basic
Program

VB911lint

Analog input of PCI-9111 through Interrupt operation Visual Basic
Program

VB9111PreTrg

Pre-trigger with Double buffer mode analog input of PCI-9111 through
Interrupt operation
Visual Basic Program

VB9111Scan

Autoscan Analog input of PCI-9111
Visual Basic Program

PCI-9112

SDK9112

A/D conversion, D/A conversion, D/I, and D/O of PCI9112/cPCI-9112
Visual C/C++ program

SDK9112DMA

Analog input of PCI-9112/cPCI-9112 through DMA data transfer
Visual C/C++ Program

SDK9112DbfDma

Double buffer mode analog input of PCI-9112/cPCI-9112 through DMA
data transfer
Visual C/C++ sample program

C9112File

1. Analog input of PCI-9112 through DMA data transfer
2.  Storing the data to disk
Visual C/C++ console Program

C9112DbfFile

1. Double buffer mode analog input of PCI-9112 through DMA data
transfer

2. Storing the data to disk

Visual C/C++ console Program

AID conversion, D/A conversion, D/I, and D/O of PCI9112/cPCI-9112

VB9112 Visual Basic Program
Double buffer mode analog input of PCI-9112/cPCI-9112 through DMA
VB9112DbfDma data transfer

Visual Basic Program
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Card Type

Sample Name

Description

SDK9113

A/D conversion, D/A conversion, D/I, and D/O of PCI-9113 Visual C/
C++ Program

SDK9113Int

Analog input of PCI-9113 through Interrupt operation Visual C/C++
Program

SDK9113DbfInt

Double buffer mode analog input of PCI-9113 through Interrupt
operation
Visual C/C++ sample program

PCI-9113

C9113File

1. Analog input of PCI-9113 through Interrupt operation
2. Storing the data to disk
Visual C/C++ console Program

C9113DbfFile

1. Double buffer mode analog input of PCI-9113 through Interrupt
operation

2. Storing the data to disk

Visual C/C++ console program

VB9113

AID conversion, D/A conversion, D/I, and D/O of PCI-9113 Visual
Basic Program

VB9113Int

Analog input of PCI-9113 through Interrupt operation Visual Basic
Program

VB9113Scan

Autoscan Analog input of PCI-9113
Visual Basic Program

SDK9114

AID conversion, D/A conversion, D/I, and D/O of PCI-9114 Visual C/
C++ Program

SDK91141Int

Analog input of PCI-9114 through Interrupt operation Visual C/C++
Program

SDK9114DbfInt

Double buffer mode analog input of PCI-9114 through Interrupt
operation
Visual C/C++ sample program

PCI-9114

C9114File

1. Analog input of PCI-9114 through Interrupt operation
2. Storing the data to disk
Visual C/C++ console Program

C9114DbfFile

1. Double buffer mode analog input of PCI-9114 through Interrupt
operation

2. Storing the data to disk

Visual C/C++ console Program

VB9114

A/D conversion, D/A conversion, D/I, and D/O of PCI-9114 Visual
Basic Program

VB9114iInt

Analog input of PCI-9114 through Interrupt operation Visual Basic
Program

VB9114Scan

Autoscan Analog input of PCI-9114
Visual Basic Program
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Card Type

Sample Name

Description

cPCI-9116

SDK9116

AID conversion of cPCI-9116
Visual C/C++ Program

SDK9116ScanDma

Software trigger with Single buffer mode analog input of cPCI-9116
through DMA data transfer
Visual C/C++ Program

SDK9116PostTrg

Post trigger with Single buffer mode analog input of cPCI-9116
through DMA data transfer
Visual C/C++ Program

SDK9116MidTrg

Middle trigger with Single buffer mode analog input of cPCI-9116
through DMA data transfer
Visual C/C++ Program

SDK9116D1yTrg

Delay trigger with Single buffer mode analog input of cPCI-9116
through DMA data transfer
Visual C/C++ Program

SDK9116DbfDma

Double buffer mode analog input of cPCI-9116 through DMA data
transfer
Visual C/C++ Program

SDK9116DbfAboutTrg

Middle trigger with Double buffer mode analog input of cPCI-9116
through DMA data transfer
Visual C/C++ Program

SDK9116DbfPostTrg

Post trigger with Double buffer mode analog input of cPCI-9116
through DMA data transfer
Visual C/C++ Program

SDK9116DbfDIyTrg

Delay trigger with Double buffer mode analog input of CPCI-9116
through DMA data transfer
Visual C/C++ Program

C9l16File

1. Analog input of cPCI-9116 through DMA data transfer
2.  Storing the data to disk
Visual C/C++ console Program

C9116DbfFile

1. Double buffer mode analog input of cPCI-9116 through DMA
data transfer

2. Storing the data to disk

Visual C/C++ console Program

VB9116

Analog input of CPCI-9116 through DMA data transfer Visual Basic
Program

PCI-9118

SDK9118

A/D conversion, D/A conversion, D/I, and D/O of PCI-9118 Visual C/
C++ Program

SDK9118DbfAboutTrg

About trigger with Double buffer mode analog input of PCI-9118
through DMA data transfer
Visual C/C++ Program

SDK9118BurstDma

Analog input of PCI-9118 through Burst Mode DMA data transfer
Visual C/C++ Program

SDK9118DbfDma

Double buffer mode analog input of PCI-9118 through DMA data
transfer
Visual C/C++ Program
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Card Type

Sample Name

Description

SDK9118HRDbfDma

Double buffer mode analog input of PCI-9118HR through DMA data
transfer
Visual C/C++ Program

SDK9118ScanDma

Autoscan Analog input of PCI-9118 through DMA data transfer
Visual C/C++ Program

SDK9118HRScanDma

Autoscan Analog input of PCI-9118HR through DMA data transfer
Visual C/C++ Program

SDK9118DbfPreTrg

Pre-trigger with Double buffer mode analog input of PCI-9118 through
DMA data transfer
Visual C/C++ Program

SDK9118DbfPostTrg

Post trigger with Double buffer mode analog input of PCI-9118 through
DMA data transfer
Visual C/C++ sample program

SDK9118AboutTrg

About trigger with Single buffer mode analog input of PCI-9118
through DMA data transfer
Visual C/C++ Program

SDK9118HRAboutTrg

About trigger with Single buffer mode analog input of PCI-9118HR
through DMA data transfer
Visual C/C++ Program

PCI-9118

SDK9118PostTrg

Post trigger with Single buffer mode analog input of PCI-9118 through
DMA data transfer
Visual C/C++ Program

Co118File

1. Analog input of PCI-9118 through DMA data transfer
2.  Storing the data to disk
Visual C/C++ console Program

C9118DbfFile

1. Double buffer mode analog input of PCI-9118 through DMA data
transfer

2. Storing the data to disk

Visual C/C++ console Program

VB9118DgHr

A/D conversion, D/A conversion, D/I, and D/O of PCI9118DG/HR
Visual Basic Program

VB9118Hg

A/D conversion, D/A conversion, D/I, and D/O of PCI9118HG
Visual Basic Program

VB9118AboutTrg

About trigger with Single buffer mode analog input of PCI-9118
through DMA data transfe
Visual Basic Program

VB9118PostTrg

Post trigger with Single buffer mode analog input of PCI-9118 through
DMA data transfe
Visual Basic sample program

VB9118Dma

Analog input of PCI-9118 through DMA data transfer
Visual Basic Program
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Card Type Sample Name Description
R e
C9221A1Dma_ExtD C{Eu;?g\;grfiogrg;ffr:]&ZZl with external trigger
C9221AIDmaToFi le C{Eu;?g\;grfiogrg;ffr:]&ZZl Stores acquired data to a disk file
fnestng ooz
C9221A1Pol I_MultiChn C{LE;'E%S%%’:;? for multiple channels
922140 C{guglf (Fi,lcclﬁzgiogram
e
erom LD e

C9221D10_Port

D/l and D/O of PCI-9221
Visual C/C++ Program

General-Purpose Timer/Counter of PCI-9221

C9221GPTC Visual C/C++ Program
AID conversion of PCI-9221
SDK9221A1Dma Visual C/C++ Program
Double buffer mode analog input of PCI-9221 through DMA data
SDK9221A1Dmabbf transfer

Visual C/C++ Program

SDK9221A1DmabbfCal IBack

Double buffer mode analog input of PCI-9221 through DMA data
transfer
Visual C/C++ Program

SDK9221D10

D/l and D/O of PCI-9221
Visual C/C++ Program

VB9221AlIDma

A/D conversion of PCI-9221
Visual Basic Program
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Card Type

Sample Name

Description

PCI-9222

€9222_Al_Polling

A/D Polling
Visual C/C++ Program

C9222_Al_DMA

A/D Continuous Conversion
Visual C/C++ Program

€9222_Al_DMA_Event

A/D Continuous Conversion with AIEnd Event Call Back
Visual C/C++ Program

C9222_Al_DMA_ExtDtoFile

A/D Continuous Conversion with External Digital Trigger
Visual C/C++ Program

C9222_Al_DMA_ReTrigger

A/D Continuous Conversion with External Digital Re-trigger
Visual C/C++ Program

C9222_Al_DMA_InfiniteReTrigger

A/D Continuous Conversion with Infinite External Digital Re-trigger
Visual C/C++ Program

C9222_Al_DMA_ReTrigEvent

A/D Continuous Conversion with External Digital Re-trigger and Tri-
gEvent/AlEnd Event Call Back
Visual C/C++ Program

C9222_Al_DMA_GatedTrigger

A/D Continuous Conversion with Gated Trigger Mode
Visual C/C++ Program

C9222_Al_DMA_DBFtoFile

A/D Infinite Conversion with Double Buffer Mode
Visual C/C++ Program

C9222_Al1_DMA_DBFOverrun

A/D Infinite Conversion with Double Buffer Mode and Double Buffer
Overrun Check
Visual C/C++ Program

€9222_Al_DMA_DBFEvent

A/D Infinite Conversion with Double Buffer Mode and DBEvent/AlEnd
Event Call Back
Visual C/C++ Program

C€9222_A0_Polling

D/A Polling
Visual C/C++ Program

C9222_A0_DMA_SimuWrites

D/A Simultaneous Continuous Update
Visual C/C++ Program

C9222_A0_DMA_WaveRepeat

D/A Continuous Update with Waveform Repeat
Visual C/C++ Program

C9222_A0_DMA_ReTrigEvent

D/A Continuous Update with External Digital Re-trigger Mode and Tri-
gEvent/AOENd Event Call Back
Visual C/C++ Program

C9222_A0_DMA_InfiniteDReTrigger

D/A Continuous Update with Infinite External Digital Re-trigger
Visual C/C++ Program

€9222_A0_DMA_DBF

D/A Infinite Continuous Update with Double Buffer Mode
Visual C/C++ Program

€9222_A0_DMA_DBFEvent

D/A Infinite Continuous Update with Double Buffer Mode and DBEv-
ent/AOENd Event Call Back
Visual C/C++ Program

€9222_DI0_Polling

DIO Polling
Visual C/C++ Program

€9222_DI_DMA

DI Continuous Conversion
Visual C/C++ Program

C9222_DI_DMA_Retrigger

DI Continuous Conversion with External Digital Re-trigger
Visual C/C++ Program

C9222_DI_DMA_InfiniteReTrigger

DI Continuous Conversion with Infinite External Digital Re-trigger
Visual C/C++ Program
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Card Type Sample Name Description
- DI Infinite Continuous Conversion with Double Buffer Mode
C9222_DI_DMA_DBFtoFile Visual C/C+ Program
DI Infinite Continuous Conversion with Double Buffer Mode and DBEv-
C9222_DI1_DMA_DBFEvent ent/DIEnd Event Call Back
Visual C/C++ Program
DO Continuous Update
€9222_DO_DMA Visual C/C++ Program
DO Continuous Update with DOEnd Event Call Back
9222_DO_DWA_Event Visual C/C++ Program
R DO Continuous Update with Delay Trigger
C9222_DO_DMA_DelayTrigger Visual C/C++ Program Yy Trgg
PCl-9222 DO Continuous Update with External Digital Re-trigger and TrigEvent/
C9222_DO_DMA_ReTrigEvent DOENd Event Call Back
(cont.) Visual C/C++ Program

C9222_DO_DMA_InfiniteReTrigger

DO Continuous Update with Infinite External Digital Re-trigger
Visual C/C++ Program

C9222_Encoder

CWI/CCW, x1, x2, x4 AB Phase Encoder
Visual C/C++ Program

C9222_Encoder_Event

CWI/CCW, x1, x2, x4 AB Phase Encoder with Encoder Position Trig-
ger/Event
Visual C/C++ Program

C9222_GPTC

General Purpose Timer/Counter
Visual C/C++ Program

C9222_Calibration

A/D and D/A Auto Calibration
Visual C/C++ Program
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Card Type

Sample Name

Description

PCI-9223

€9223_Al_Polling

A/D Polling
Visual C/C++ Program

€9223_AI_DMA

A/D Continuous Conversion
Visual C/C++ Program

€9223_Al_DMA_Event

A/D Continuous Conversion with AIEnd Event Call Back
Visual C/C++ Program

C9223_Al_DMA_ExtDtoFile

A/D Continuous Conversion with External Digital Trigger
Visual C/C++ Program

C9223_Al_DMA_ReTrigger

A/D Continuous Conversion with External Digital Re-trigger
Visual C/C++ Program

C9223_Al_DMA_InfiniteReTrigger

A/D Continuous Conversion with Infinite External Digital Re-trigger
Visual C/C++ Program

C9223_Al_DMA_ReTrigEvent

A/D Continuous Conversion with External Digital Re-trigger and Tri-
gEvent/AlEnd Event Call Back
Visual C/C++ Program

C9223_Al_DMA_GatedTrigger

A/D Continuous Conversion with Gated Trigger Mode
Visual C/C++ Program

C9223_Al_DMA_DBFtoFile

A/D Infinite Conversion with Double Buffer Mode
Visual C/C++ Program

C9223_Al_DMA_DBFOverrun

A/D Infinite Conversion with Double Buffer Mode and Double Buffer
Overrun Check
Visual C/C++ Program

€9223_Al_DMA_DBFEvent

A/D Infinite Conversion with Double Buffer Mode and DBEvent/AlEnd
Event Call Back
Visual C/C++ Program

C9223_A0_Polling

D/A Polling
Visual C/C++ Program

C9223_A0_DMA_SimuWrites

D/A Simultaneous Continuous Update
Visual C/C++ Program

C9223_A0_DMA_WaveRepeat

D/A Continuous Update with Waveform Repeat
Visual C/C++ Program

C9223_A0_DMA_ReTrigEvent

D/A Continuous Update with External Digital Re-trigger Mode and Tri-
gEvent/AOENd Event Call Back
Visual C/C++ Program

C9223_A0_DMA_InfiniteDReTrigger

D/A Continuous Update with Infinite External Digital Re-trigger
Visual C/C++ Program

€9223_AO_DMA_DBF

D/A Infinite Continuous Update with Double Buffer Mode
Visual C/C++ Program

€9223_A0O_DMA_DBFEvent

D/A Infinite Continuous Update with Double Buffer Mode and DBEv-
ent/AOENd Event Call Back
Visual C/C++ Program

€9223_DI0_Polling

DIO Polling
Visual C/C++ Program

€9223_DI_DMA

DI Continuous Conversion
Visual C/C++ Program

C9223_DI_DMA_Retrigger

DI Continuous Conversion with External Digital Re-trigger
Visual C/C++ Program

C9223_DI_DMA_InfiniteReTrigger

DI Continuous Conversion with Infinite External Digital Re-trigger
Visual C/C++ Program
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Card Type Sample Name Description
- DI Infinite Continuous Conversion with Double Buffer Mode
€9223_DI_DMA_DBFtoFile Visual C/C+ Program
DI Infinite Continuous Conversion with Double Buffer Mode and DBEv-
C9223 DI_DMA_DBFEvent ent/DIEnd Event Call Back
Visual C/C++ Program
DO Continuous Update
€9223_DO_DMA Visual C/C++ Program
DO Continuous Update with DOEnd Event Call Back
€9223_DO_DWA_Event Visual C/C++ Program
R DO Continuous Update with Delay Trigger
C9223_DO_DMA_DelayTrigger Visual C/C++ Program Yy Trgg
PCl1-9223 DO Continuous Update with External Digital Re-trigger and TrigEvent/
C9223_DO_DMA_ReTrigEvent DOENd Event Call Back
(cont.) Visual C/C++ Program

C9223_DO_DMA_InfiniteReTrigger

DO Continuous Update with Infinite External Digital Re-trigger
Visual C/C++ Program

C9223_Encoder

CWI/CCW, x1, x2, x4 AB Phase Encoder
Visual C/C++ Program

C9223_Encoder_Event

CWI/CCW, x1, x2, x4 AB Phase Encoder with Encoder Position Trig-
ger/Event
Visual C/C++ Program

C9223_GPTC

General Purpose Timer/Counter
Visual C/C++ Program

C9223_Calibration

A/D and D/A Auto Calibration
Visual C/C++ Program
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Card Type Sample Name Description
- A/D Fast Polling
Al_Polling Visual C/C++ Program
A/D Fast Channels-Scan Polling
Al_ScanChannels Visual C/C++ Program
A/D Continuous Conversion
Al_ContDma Visual C/C++ Program
- A/D Continuous Conversion
Al_ContDmaFile Visual C/C++ Program
A/D Continuous Conversion with External Digital Trigger
Al_ContDmaExtD Visual C/C++ Program
Al ContScans A/D Continuous Channels-Scan Conversion
= Visual C/C++ Program
- A/D Continuous Channels-Scan Conversion
Al_ContScansFile Visual C/C++ Program
A/D Continuous Channels-Scan Conversion with QD/PG Internal Trig-
Al_ContScansExtTrig ger
Visual C/C++ Program
A/D Infinite Continuous Conversion with Double Buffer Mode
PCI-9524 Al_ContbbfDma Visual C/C++ Program
A/D Infinite Continuous Conversion with Double Buffer Mode and
Al_ContDbfDmaFi leExtD External Digital Trigger
Visual C/C++ Program
A/D Infinite Continuous Channels-Scan Conversion with Double Buffer
Al_ContDbfScansFile Mode
Visual C/C++ Program
D/A Polling
AO_PollUpdate Visual C/C++ Program
- D/A Simultaneous Polling
AO_SimuUpdate Visual C/C++ Program
- DIO Polling
DIO_Polling Visual C/C++ Program
R CLK/DIR, CW/CCW Pulse Generation
CTR_PulseGenration Visual C/C++ Program
X4 AB Phase Decoder
CTR_QuadratureDecoder Visual CIC++ Program
calibration D/A Infinite Continuous Update with Double Buffer Mode
Visual C/C++ Program
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SDK9812SoftTrg

Software trigger with Single buffer mode analog input of PCI-9812/
cPClI-9812 through DMA data transfer
Visual C/C++ Program

SDK9812PreTrg

Pre-trigger with Single buffer mode analog input of PCI-9812/cPCl-
9812 through DMA data transfer
Visual C/C++ Program

SDK9812PostTrg

Post trigger with Single buffer mode analog input of PCI-9812/cPCI-
9812 through DMA data transfer
Visual C/C++ Program

SDK9812MidTrg

Middle trigger with Single buffer mode analog input of PCI-9812/cPClI-
9812 through DMA data transfer
Visual C/C++ Program

SDK9812DelayTrg

Delay trigger with Single buffer mode analog input of PCI-9812/cPCI-
9812 through DMA data transfer
Visual C/C++ Program

SDK9812DbfMidTrg

Middle trigger with Double buffer mode analog input of PCI-9812/
cPCI-9812 through DMA data transfer
Visual C/C++ Program

PCI-9812

SDK9812DbfPreTrg

Pre-trigger with Double buffer mode analog input of PCI-9812/cPCI-
9812 through DMA data transfer
Visual C/C++ Program

SDK9812DbfPostTrg

Post trigger with Double buffer mode analog input of PCI-9812/cPCI-
9812 through DMA data transfer
Visual C/C++ Program

SDK9812DbfDelayTrg

Delay trigger with Double buffer mode analog input of PCI-9812/cPCI-
9812 through DMA data transfer
Visual C/C++ Program

C9812File

1. Analog input of PCI-9812/10 through DMA data transfer
2. Storing the data to disk
Visual C/C++ console Program

C9812DbfFile

1. Double buffer mode analog input of PCI-9812/10 through DMA
data transfer

2. Storing the data to disk

Visual C/C++ console Program

VB9812

Analog input of PCI-9812/cPCI-9812 through DMA data transfer
Visual Basic 4.0 Program

9812 VB5

Analog input of PCI-9812/cPCI-9812 through DMA data transfer
Visual Basic 5.0 Program

NOTE

The PCIS-DASK comes with Examples.exe - a sample
program browser that allows you to view and execute all
bundled sample programs. Examples.exe is located in
<InstallDir>\Samples directory. After launching Exam-
ples.exe, double-click the icon of the sample you want to

execute.
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7.2 Development Environments

Visual Basic Sample Programs

Several Visual Basic sample programs are provided for each card.
Using VB9112DMA as example, the following files are included in
each sample program:

» VB project file - VB9112D.VBP
» VB form files - VB9112D.FRM
» Executable file - VB9112D.EXE

You must install a 32-bit Microsoft® Visual Basic 4.0 Professional
Edition or higher to view these sample programs. Refer to Micro-
soft® Visual Basic 4.0 Professional Edition manual or related refer-
ence books to get the information on using Visual Basic 4.0.

If you want to execute the VB sample programs without installing
Microsoft® Visual Basic 4.0, use the VB4 Runtime package. The
VB4 Runtime package includes the required library and DLL files
to run the VB sample programs. You can find this package from
the main setup window or root directory of the ADLINK All-In-One
CD.

Microsoft C/C++ Sample Programs

The PCIS-DASK also includes Microsoft® C/C++ sample pro-
grams featuring similar functions as those provided by VB sam-
ples. These may be directly executed and do not require
installation of any additional package. It is recommended that you
use Microsoft® C/C++ sample programs when testing the PCIS-
DASK packages.

Using SDK7200WAV as example, the following files are included
in each sample program:
» C source file - 7200WAV.C
Workspace file - 7200WAV.MDP
Resource script file - 7200WAV.RC, RESOURCE.H
Make file - 7200WAV.MAK

>
>
>
» Executable file - 7200WAV.EXE
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You can use any Microsoft® Visual C++ 4.0 editor to view or mod-
ify these source files. However, you must install Microsoft® Visual
C++ 4.0 or higher to build the executable 7200WAV.EXE. Refer to
the Microsoft® Visual C++ manual or related reference books for
additional information.
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7.3 Execute Sample Programs
To run the sample programs:
1. Open the sample program

You can use Microsoft Visual C++ 4.0 or Visual Basic 4.0 to
open and execute the sample programs. Or you can run the
executable files directly.

2. Set the testing parameters

Depending on your requirements, set the testing parameters
such as A/D or D/A conversion, testing channels, sampling
rate, transfer count, etc.

3. Click the Start button to run the program.
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7.4 Detailed Descriptions of Programs

Four types of sample programs are provided together with the
PCIS-DASK software driver:

» AD conversion, D/A conversion, and D/O
» Data I/O through DMA Data Transfer or Interrupt operation

» Double buffer mode data 1/0O through DMA transfer or Inter-
rupt operation

» Trigger Mode Data I/O through DMA Data Transfer or Inter-
rupt operation

NOTE The following sections describing these types of sample
programs use the VB 9112, SDK 9112DMA, SDK
9112CDMA and SDK 9118 DbfPreTrg screens as exam-
ples.
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A/D Conversion, D/A Conversion, D/I, and D/O

This sample illustrates how to use the PCIS-DASK to operate soft-
ware trigger with program polling data mode and read/write data
from digital input/output channels on PCI-9112. The main program
main screen is shown below:

wallz M=
Board Loz Exit!
Analog Input (A/D)
Channel
v o[=] 4[]
10 5H
o 2 s
L s 70
; Channel
T 8[]12[]
[l 130
© 10 14
1[0 151
Digital Input Analog Dutput [D/A)——
Q90O 0GOOCOOBOBO| | channet 1:[sine wav =]
15 1413 1211 10 8 8 7 6 5 4 3 2 1 0 |Channell:
Digital Output
([#8000080800008080|
Lianus Log File
LZev 3|
stat | Stop | Fause

Analog Input (A/D). Shows the results of A/D conversion. You
can select the input channels (allows multiple channels) and the
input range (gain) you want to test.

Analog output (D/A). Shows the results of D/A conversion. You
may turn the tuner to set the output voltage. You can also set the
output waveform to sine or square.

D/l and D/O. Shows the results of read/write data from/to digital
input/output channels. To set the output value, click the channel
buttons. A red color indicates an ON channel, while a white color
indicates an OFF channel.
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Data I/O Through DMA Data Transfer or Interrupt Operation

This program demonstrates the use of PCIS-DASK to operate
data 1/0 through DMA data transfer or Interrupt operation. The
program main screen is shown below.

: 9112 Autoscan DMA M=l B3
Exitl
DMA InputfA/D)

Vohis Signals
5.00

2.50

0.00

-2.50
/

Data Value

These programs allow you to adjust the input channels, input
range (PCI-7200 does not have these two options), sampling rate,
and data size (transfer count).

To view the input data, click on the Data Value button in the main
screen when data transfer is finished. Refer to the following
screen.

DMA TEST

51 |
80 :|
19

do

191
140
191
1al

191 =

R N R )

Data Transferred : 4000
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Double Buffer Mode Data I/O Through DMA Transfer or
Interrupt Operation

This program tells you how to use PCIS-DASK to operate double-
buffered data 1/0 through DMA transfer or Interrupt operation. The
program main screen is shown below:

i PCI-9112 Double Buffered DMA [_[o]x]
Esil

Signals Channel

Range: +-5Y

40 :I 4000 Start Stop Data Value

These programs lets you input channel, input range (PCI-7200
does not have this two options), sampling rate, and data size
(transfer count).

To view the input data, click on the Data Value button in the main
screen after you stop the double-buffered operation.
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Trigger Mode Data I/0O Through DMA Data Transfer or
Interrupt Operation

These programs tell you how to use PCIS-DASK to operate trigger
mode data I/0O through DMA data transfer or interrupt operation.
Except for the additional input item postCount, the main screen of
these programs are similar with Single-Buffer Mode or Double-
Buffer Mode programs. Please refer to these two sections for the
details.

The postCount item represents the number of data accessed
after a specific trigger event or the counter value for deferring to
access data after a specific trigger event. Refer to the description
of Al configuration functions (Al_9111 Config, Al_9118 Config,
Al_9812_ Config) for details.

: PCI-9118 Double Buffered DMA with Post Trigger i i
Exitl

Signals Channel

Range: +5V

1024

10 :I 1026 Start Stop | Data Value

NOTE Except for VB9812, all trigger mode data acquisition sam-
ple programs use external digital trigger source to provide
trigger signal. Refer to the card’s documentation if you
you want to operate for the detailed description of trigger
mode data acquisition.
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8 Distribution of Applications

8.1

Required Files

When installing an application that uses PCIS-DASK on another
computer, you must install the necessary driver files and support-
ing libraries on the target system. You can create an automatic
installer that installs your program and all files needed to run the
program or you can install the program and program files manually
For both installation methods, you must install the following files:

Required support DLLs: Pci-dask.dll

Driver files
Windows® 98

>

>

Corresponding driver files in \Software\Pcis-
dask\W98NT2K \redist\W98\drivers (e.g. pci7200.sys for
PCI-7200). These files must be copied to the Win-
dows\system32\drivers directory.

Corresponding INF files in \Software\Pcis-dask\W98NT2K
\redist\W98\Inf (e.g. p7200.inf for PCI-7200). These files
must be copied to the Windows\inf directory.

Device configuration utility in \Software\Pcis-
dask\W98NT2K\redist\W98\Util.

Windows® NT 4.0

4

4

adldask.sys in \Software\Pcis-
dask\W98NT2K\redist\Wnt\drivers. This file must be cop-
ied to Winnt\system32\drivers directory.

Corresponding driver files in \Software\Pcis-
dask\W98NT2K \redist\Wnt\drivers (e.g. pci7200.sys for
PCI-7200). These files must be copied to
Winnt\system32\drivers directory.

Device configuration utility in \Software\Pcis-
dask\W98NT2K/redist\Wnt\Util.

Windows® 2000

>

Corresponding driver file in \Software\Pcis-
dask\W98NT2K \redist\W2000\drivers (e.g. pci7200.sys
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for PCI-7200). These files must be copied to
Winnt\system32\drivers directory.

» Corresponding INF file in \Software\Pcis-dask\W98NT2K
\redist\W2000\Inf (e.g. p7200.inf for PCI-7200). These files
must be copied to Winnt\inf directory.

» Device configuration utility in \Software\Pcis-
dask\W98NT2K \redist\W2000\Util.

Utility file (option)

» Data conversion utility DAQCvt.exe in \Software\Pcis-
dask\ W98BNT2K\redist\W98\Util, \Software\Pcis-
dask\W98BNT2K\redist\Wnt\Util, or \Software\Pcis-
dask\W98NT2K\redist\W2000\Util to convert the binary
data file to an easily read file format.
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8.2 Automatic Installers

Several programming environments provide setups or distribution
kit tools that automatically create an installation program so that it
can be conveniently installed from one computer to another. For
the application to function properly, this tool must locate and
include the required control files and supporting libraries in the
installation program that it creates.

Some tools, such as the Visual Basic 5 Setup Wizard, uses
dependency files to determine which libraries are required by a VB
application. Some setup tools may not automatically recognize
which files are required by a program, but they provide an option
to add additional files to the installation program. In this case, ver-
ify that all the necessary files described in the previous section are
included. The user should also check if the resulting installation
program does not copy older versions of a file over a newer ver-
sion on the target computer.

If the programming environment does not provide a tool or wizard
for building an installation program, third-party tools such as
InstallShield may be used instead. Some programming environ-
ments provide simplified or trial versions of third-party installer cre-
ation tools on their installation CDs.
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8.3 Manual Installation

If the programming environment does not include a setup or distri-
bution kit tool, the installation task may be performed manually. To
install the program to another computer:

1. Copy the program executable to the target computer.

2. Copy all required PCIS-DASK files described in the sec-
tion 8.1 to the appropriate directory on the target com-
puter.

3. Use NuDAQ Device Configuration utility to configure the
device.

NOTE Do not replace a newer version of a file installed in the tar-
get computer.
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